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Rocket U2 DBTools overview
These release notes provide information about fixes made to the 4.3.0 U2 DBTools.

Build: 2715
Release Date: July 2017

Important news at this release

Beginning at 4.3.0, Apple Mac OS X users will be unable to install DBTools v4.2.0 on Eclipse Mars or
Neon.

Important:  It is recommended that users backup their previously installed DBTools directory
before installing v4.3.0. This is normally found in C:\U2\U2Tools\v4 (and/or v3).

To access the documentation library, Adobe Acrobat Reader must be set as your default PDF reader.

Component versions included in this release

Component Version Release Date

U2 DBTools Shared Components 4.3.0 July 2017
U2 Basic Developer Toolkit (BDT) 4.3.0 July 2017
U2 EDA Replication Configuration Tool 4.83.0 July 2017
U2 EDA Schema Manager 4.33.0 July 2017
U2 Extensible Administration Tool (XAdmin) 4.13.0 July 2017
U2 Metadata Manager 4.73.0 July 2017
U2 RESTful Web Services 4.63.0 July 2017
U2 Web Services Developer (WSD) 4.23.0 July 2017
U2 XML/DB Mapping Tool 4.43.0 July 2017
XTOOLSUB 4.103.0 July 2017

Note:  You must use InstallShield to install this version.

When making a connection to your U2 server for the first time with this version of U2 DBTools, you may
be prompted to update the XTOOLSUB server routine. Depending on the user originally connected
to the server, you may have to supply an alternate user who has permissions to write to the installed
home directory of the database installation. After the initial update to the server, subsequent server
connections will not prompt for updates.

U2 DBTools setup

To install or upgrade a package, simply click the appropriate component name from the installer.

This package is compatible with Windows 7 Service Pack 1 or higher.

The following database tools can be installed from this package:
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Component Description

U2 Basic Developer Toolkit (BDT) This Eclipse-based tool provides a modern integrated
development tool for BASIC developers that features a resource
explorer, a dictionary editor, a code editor and an integrated
debugger.

U2 EDA Replication Configuration
Tool

The EDA Replication Configuration Tool is an Eclipse-based
tool used to replicate your data to a SQL database, in addition
to keeping your data safely stored in UniData. It allows you to
store your data in UniData while it is simultaneously replicated
to Oracle, IBM DB2, or Microsoft SQL Server. Use the replicated
database for data-mining or reporting while you use UniData as
your production workhorse.

U2 EDA Schema Manager EDA Schema Manager is an Eclipse-based tool that allows users
to create and manage schemas for conversion of data stored in a
U2 database to a 1NF database such as Microsoft SQL Server.

U2 Extensible Administration
Tool (XAdmin)

XAdmin is an Eclipse-based tool that provides a modern
integrated environment for U2 database administration.

U2 RESTful Web Services U2 RESTful Web Services enable U2 users to define and publish
U2 resources, such as data files and subroutines, to a U2 REST
server so they can be accessed in a RESTful manner.

U2 Metadata Manager The U2 Metadata Manager is an Eclipse-based, client-side tool
used to make changes to the U2 database servers. It allows users
to better describe the type of data stored in each location of their
data files and is also used to define first normal form exposure.

U2 Web Services Developer (WSD) U2 Web Services Developer is an Eclipse-based tool that allows
you to create and deploy your Web Services applications, and
manage your SOAP servers.

U2 XML/DB Mapping Tool The XML/DB Tool is a graphical user interface tool with which
you can create an XML mapping file to use when exporting
or importing XML documents with the UniData or UniVerse
databases. This is an Eclipse-based tool.

XTOOLSUB BASIC routines that provide communication with the U2
databases.

Contacting customer support

Click the following link to find worldwide contact information for Rocket Support:

https://my.rocketsoftware.com/RocketCommunity/RCEmailSupport

U2 Technical Support is available Monday through Friday, 9:00 AM to 5:00 PM in the customer’s
time zone. After-hours, weekend, and holiday support is available for customers with priority 1,
critical down systems, only. If you are experiencing a priority 1, critical down system, please call
1-855-577-4323 (Toll Free) or 1-781-577-4323 (Direct) or visit the link above for non-US phone numbers,
and leave a message with your name, a phone number where you can be reached, your U2 product
serial number, and a description of the problem. A U2 Support Engineer will return your call as soon as
possible.

https://my.rocketsoftware.com/RocketCommunity/RCEmailSupport
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Shared components
The release notes in this section provide information about new features and fixes made to the
components shared by all U2 Eclipse-based tools.

U2 DBTools Shared Components 4.3.0
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.

Fixes in 4.3.0

The following issues were fixed in this release:

Issue number Description

UDBT-2632 Beginning at this release, users running DBTools on Eclipse Galileo will be unable
to update their tools using the update site. The update site only supports Eclipse
Luna or later.

UDBT-2992 Beginning at this release, the U2 DBTools product is built on Eclipse Neon 4.6.
UDBT-3068 Apple Mac OS X only. Starting at this release, DBTools 4.3.0 can be installed on

Eclipse Mars or Neon.
UDBT-3178 Starting at this release, the Java virtual memory heap size has been changed

from 512MB to 1GB in all of the .ini files. This can be seen with the -Xmx1G
parameter.

U2 DBTools Shared Components 4.2.0
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.

Fixes in 4.2.0

There were no fixes specific to this release.

U2 DBTools Shared Components December 2015
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.

Fixes in December 2015

The following issues were fixed in this release:

Issue number Description

UDBT-1939 Beginning at this release, Rocket U2 DBTools are built on Eclipse 4.4.2.
UDBT-2496 Beginning at this release, the U2 REST and U2 WSD products are now built with the

Jetty 9.2.10 engine and meet all security requirements.
UDBT-2497 All version 4.x DBTools products have been updated to Java JRE 8 u60.
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U2 DBTools Shared Components January 2015
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.

Fixes in January 2015

The following issues were fixed in this release:

Issue Number Description

UDBT-2467 Prior to this release, certain characters being used in a password could cause U2
Resource View connections to have an error. This issue has been resolved with an
updated U2 Resource View.

UDBT-1558 In previous versions, dictionary elements could get misinterpreted in cases where
there was a corresponding SB field. An M-type field could have been changed to an
S-type field. This issue has been resolved.

U2 DBTools Shared Components August 2014
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.

Fixes in August 2014

The following issues were fixed in this release:

Issue Number Description

UDBT-1092 Prior to this release, the U2 administration tools such as XAdmin and EDA Schema
Manager did not recognize multilevel UniData files as valid file types. This issue has
been resolved.

UDBT-1829 At the AUG2014 release, IPv6 support has been implemented in the U2 DBTools.
IPv4 remains compatible.

U2 DBTools Shared Components January 2014
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.

Fixes in January 2014

Build: 2082
Release Date: January 2014

The following issues were fixed in this release:
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Issue Number Description

UDBT-1407 Prior to this release, when a user used the Ctrl + click method to select multiple
elements, such as servers, from the U2 Resource view and then clicked Delete,
only the first server selected was actually deleted. Beginning at this release, the U2
Resource view now supports the deletion of multiple elements. This issue has been
resolved.

U2 DBTools Shared Components November 2013
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.

Fixes in November 2013

Build: 2054
Release Date: November 2013

There were no fixes specific to this release.

U2 DBTools Shared Components October 2013
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.

Fixes in October 2013

Build: 2025
Release Date: October 2013

There were no fixes specific to this release.

U2 DBTools Shared Components June 2013
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.

Fixes in June 2013

Build: 1114
Release Date: June 2013

There were no fixes specific to this release.

U2 DBTools Shared Components May 2013
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.
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Fixes in May 2013

Build: 1108
Release Date: May 2013

There were no fixes specific to this release.

U2 DBTools Shared Components March 2013
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.

Fixes in March 2013

Build: 1099
Release Date: March 2013

The following issues were fixed in this release:

Issue Number Description

UDBT-1296 Prior to this release, the XTOOLSUB deployment log noted the completion of the
deployment process, but did not indicate success or failure. The log file now states
whether the XTOOLSUB deployment has been successful. This issue has been
resolved.

UDBT-1277 XTOOLSUB would fail to deploy correctly after a UniVerse upgrade, causing users
to be unable to use upgraded versions of the U2 DBTools. XTOOLSUB now deploys
as expected. This issue has been resolved.

UDBT-1204 The U2 DBTools are now certified for Windows 8 and Windows 2012.
UDBT-1050 Prior to this release, when users hovered over a file in the U2 Resource view, the

configuration pattern filter would open and have to be closed before users could
continue their work. Beginning at this release, the behavior for the configuration
pattern filter has changed, and the filter is turned off by default. To turn the filter
on, navigate to Window > Preferences > UniData/UniVerse and then select
Enable Pattern Configuration.

U2 DBTools Shared Components November 2012
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.

Fixes in November 2012

Build: 1080
Release Date: November 2012

There were no fixes specific to this release.
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U2 DBTools Shared Components May 2012
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.

Fixes in May 2012

Build: 1050
Release Date: May 2012

The following issues were fixed in this release:

Issue Number Description

UDBT-974 U2 DBTools attempts to detect the multivalue status of a field in various
contexts.  If Attribute 6 is empty, U2 DBTools looks for an SB+ version of the field
(.FieldName) to use as an override to get the multivalue status.  If an SB+ field is
located, the multivalue status for that field is used when displaying dictionary data
for the standard field.

▪ On UniData, the multivalue status is returned as "MV" for all multivalue and
multi-subvalue fields.

▪ On UniVerse, the multivalue status is returned as "M" for all multivalue fields.

Prior to this release, the return value was incorrectly returned as “M” for UniVerse
files. This issue has been resolved.

U2 DBTools Shared Components March 2012
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.

Fixes in March 2012

Build: 1050
Release Date: March 2012

The following issues were fixed in this release:

Issue Number Description

UDBT-974 U2 DBTools attempts to detect the multivalue status of a field in various
contexts.  If Attribute 6 is empty, U2 DBTools looks for an SB+ version of the field
(.FieldName) to use as an override to get the multivalue status.  If an SB+ field is
located, the multivalue status for that field is used when displaying dictionary data
for the standard field.

▪ On UniData, the multivalue status is returned as "MV" for all multivalue and
multi-subvalue fields.

▪ On UniVerse, the multivalue status is returned as "M" for all multivalue fields.

Prior to this release, the return value was incorrectly returned as “M” for UniVerse
files. This issue has been resolved.
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Shared Components 3.x
These release notes provide information about fixes to the components shared by all U2 Eclipse-based
tools.

Fixes in 3.x

Build: 1022
Release Date: January 2012

The following issues were fixed in this release:

Issue Number Description

UDBT-370 For UniVerse only, when a user created a new file, deleted the voc pointer file and
then tried to create a new file with the same name, the Eclipse tool would hang.
This problem no longer occurs and a pop-up window now displays, telling users
that the file already exists but is missing the VOC entry.

UDBT-372 Beginning at this release, the U2 Eclipse-based tool installation includes the Oracle
Java Runtime Environment (JRE) 1.6. The IBM JRE is no longer part of the U2
Eclipse-based client installation.

UDBT-374 All U2 Eclipse-based tools now include filtering and paging capabilities in the U2
Resource View.

UDBT-376 All U2 Eclipse-based tools have been upgraded to use Eclipse 3.5.2. Previously, the
tools ran on Eclipse 3.3.1.1.

UDBT-375 A client-based server deployment tool has been added to the U2 Eclipse-based
tools. This allows users to more easily apply updates to XTOOLSUB and to upgrade
accounts. This issue is related to UDBT-379.

UDBT-379 Beginning at this release, all U2 Eclipse-based tools will automatically check the
XTOOLSUB version and update the server if the version is out of date.

UDBT-380 Beginning a this release, all U2 Eclipse-based tools have been fully rebranded with
all references to IBM removed from package names. U2 Package names now begin
with "com.rs.u2...".

UDBT-634 For all U2 Eclipse-based tools, when you create a new account the U2 Resource
view now allows you to define Owner names, Group names, and user permissions.

UDBT-649 Beginning at this release, the U2 tools are being delivered as a separate package
and are no longer shipped with the U2 clients. Because of this, the installation
details have changed, as follows:

▪ Each U2 tool can be installed separately from the U2 Tools installation tool.

▪ The U2 Tools are now installed in the C:\U2\U2Tools\v3 directory.

This affects only newly installed tools. Tools not upgraded will remain in C:
\U2\U2Tools.

Note:  The old versions of the tools do not contain registered path details for all of
the components. If you try to install the new versions of the tools into a location
other than where they were installed previously, the configuration details are not
carried over. To fix this, manually copy the configuration details over from the
_workspace and _configuration directories for the appropriate component.
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U2 Basic Developer Toolkit
The release notes in this section provide information about changes in U2 Basic Developer Toolkit.

The UniData and UniVerse Basic Developer Toolkit (BDT) provides a modern integrated development
tool for Basic Developers that features a Resource Explorer, a Dictionary Editor, a Code Editor, and an
Integrated Debugger.

U2 Basic Developer Toolkit 4.3.0
These release notes provide information about fixes in Basic Developer Toolkit (BDT).

Fixes in U2 BDT 4.3.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue number Description

UDBT-2758 UniData only. Prior to this release, BDT would not save the Basic Type when
compiling a BASIC program and users would have to select the basic type each
time they compiled. This issue has been resolved.

UDBT-2941 Previously, after installing UDBT version 4 for BDT and updating the software
from the update site, the installation would break. Users may have experienced
warnings. The jar signing portion of the update site has been updated to fix the
warnings and allow the jars to pass validation during the update.

UDBT-2995 Beginning at this release, BDT has been enhanced to support BASIC field-level
update statements. This feature is available at UniData 8.2.1 and is planned to be
included at UniVerse 11.3.2.

UDBT-3149 Previously, when debugging a BASIC program in BDT, the Variable Watch view
would display the values in the Value column with \r appended. This issue has
been resolved.

UDBT-3174 Beginning at UniData 8.2.0, an enhancement was added to UniBasic to control
which mark character the REMOVE statement and function stop at. This is done by
the use of the @REMOVE.ATTRIBUTE @variable. For more details, see the UniBasic
Commands Reference Guide.

UDBT-3180 Beginning at this release, users can add custom response messages when
returning from calling XTOOLSUB. The following response types are available:

▪ Text dialog box

▪ HTML page

▪ Data table

For detailed instructions on how to use this features and customizing XTOOLSUB
functionality, see the DBTools User Guide.

UDBT-3186 Beginning at this release, line numbers displayed in the Location column in the U2
Problems tab now display in numeric order.



U2 Basic Developer Toolkit 4.2.0

11

U2 Basic Developer Toolkit 4.2.0
These release notes provide information about fixes in Basic Developer Toolkit (BDT).

Fixes in U2 BDT 4.2.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

Issue number Description

UDBT-2413 Beginning at this release, the BDT Editor, Command Prompt, and Debugger have
been enhanced to support NLS on UniVerse systems

UDBT-2775 Beginning at this release, BDT is now integrated with Aldon. To enable Aldon
integration, click Windows → Preferences → UniData/UniVerse → LMe and check
the LMe flag.

UDBT-2921 Linux only. Prior to this release, when banner was enabled, users may have
experienced the following error when debugging a BASIC program using the SSH
library in BDT:

Password login failed with code 53 U2 Terminal is
requested to terminate.

The SSH library has been updated. This issue has been resolved.
UDBT-2929 Prior to this release, files written in different locations would be saved incorrectly

when BDT had the Text file encoding option set to Other UTF-8, which was the
default. Default is now the default option. This issue has been resolved.

UDBT-2949 Beginning at this release, the Basic Developer Toolkit now recognizes U2 Python
APIs.

U2 Basic Developer Toolkit 4.1.0
These release notes provide information about fixes in Basic Developer Toolkit (BDT).

Fixes in U2 BDT 4.1.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue number Description

UDBT-2443 Prior to this release, using the key stroke combination of ctrl+alt-v to insert a value
mark while editing a new program caused a java.lang.NullPointerException error.
Now the correct value, ^253, will be inserted into the program.

UDBT-2462 Prior to this release, BDT would fail when users manually inserted VM, FM, or other
system values. In addition, when saving a file with VM, FM, or other system values,
BDT would insert incorrect characters. This issue has been resolved.

UDBT-2526 Prior to this release, it was possible to see an incorrect message indicating that a
program had been changed by another user. This has now been resolved.

UDBT-2586 Prior to this release, special characters for value mark, text mark, etc. insertion
(e.g. ^254) would corrupt the server-side record. This has been resolved.
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Issue number Description

UDBT-2659 Prior to this release, changes to XTOOLSUB caused BASIC programs saved to
UniData on Windows servers to add extra char 13 characters to the end of each
line. This issue has been resolved.

U2 Basic Developer Toolkit 3.2.1
These release notes provide information about fixes in Basic Developer Toolkit (BDT).

Fixes in U2 BDT 3.2.1

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-2459 Prior to this release, when using the Recently Used option, directory type files were
duplicated. This issue has been resolved.

UDBT-2278 Prior to this release, when creating or updating a BASIC program using the Basic
Developer Toolkit, it was not replicated to the subscriber. This was due to not
supporting Sequential I/O within U2 Replication. This issue has been resolved by
changing BDT program updates to standard Database WRITE.

UDBT-1221 In previous versions, when writing code in the Basic Developer Toolkit, the
backslash delimiter could be misinterpreted, canceling out quotation marks that
follow it. This issue has been resolved.

U2 Basic Developer Toolkit 3.2.0
These release notes provide information about fixes in Basic Developer Toolkit (BDT).

Fixes in U2 BDT 3.2.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-348 In versions 1.2.3 and 1.2.4, highlighting behavior in the explorer tree changed from
the previously expected behavior. If you opened the explorer tree, double-clicked
Database Files, entered text in the Enter file pattern names field, and double-
clicked the results, the tool did not switch focus to the corresponding file as it did
in previous versions. This issue is resolved; the file is highlighted when you double-
click the result in the Open Files window.
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Issue Number Description

UDBT-1438 Prior to this release all reads from Basic Developer's Toolkit (BDT) were primary
reads. This prevented third-party source control products from properly blocking
files that were locked/checked-out by other users if they were the main program
and not an INCLUDE-ed file.

When these locked files were blocked from update but were INCLUDE files,
messages were displayed to the screen after every character was typed making it
very difficult to use the Basic Developer's Toolkit.

Starting at this release of the Basic Developer's Toolkit, BASIC program reads from
the server are broken up into two types:

▪ Primary Reads: The main basic program being opened.

▪ Secondary Reads: Files referenced by INCLUDE and INSERT type of BASIC/
UniBasic commands.

To check for secondary reads programmatically, the ReadDIRRecord (Code 53)
function has been modified. If a secondary read is done, the 4th parameter of the
X_PARAMS variable will have an 's' included in it. If this a primary read, then the
4th parameter is empty.

The following is an example of an XTOOLSUB_XPRE (on UniVerse), that will block
primary reads of a file called 'MYVARS' and allow secondary reads ('$INCLUDE
INCLUDE MYVARS') to be read. Change XTOOLSUB_XPRE to XTOOLSUB_EXECPRE if
using UniData.

 IF X_CODE = 53 THEN
   * IF X_PARAMS<3> = "MYVARS" THEN; * Original Behavior
   * New Behavior (4th parameter is 's' if secondary read)
   * This example, checks for primary reads and if primary 
       read then block it
   * With original behavior, opening the include file in BDT
       will return blank
         
   IF X_PARAMS<3> = "MYVARS" AND X_PARAMS<4> = "" THEN
      X_ERROR="X1010"
      X_OUTDATA="Unable to modify this program!"
   END
 END
RETURN 

This program will need to be globally cataloged. If using BDT at the time of this
cataloging, you will need to disconnect and reconnect to the database server to
test any changes.

Note:  If the INCLUDE file (MYVARS in example) is opened as part of another file
(secondary read) and then you open the include file directly, it will open a local
copy of the file. It is recommended to have a check against the WriteDIRRecord
(Code 54) function to help in this situation, if the user tries to write this file
back to the server. However, there have been no modifications made to the
WriteDIRRecord function in this product change. Also, if a secondary read fails, BDT
will not attempt to read the file again.

UDBT-1541 In version 3.0.6, the BASIC Developers Toolkit sometimes returned inappropriate
errors if you used the compiler to compile a program with your own $INCLUDE
code. The tool returned errors on valid commands, but it compiled the program
anyway. This issue is resolved.
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Issue Number Description

UDBT-1709 Prior to this release, when a user connected to an account and opened the
Database Files node in BDT, it loaded all the database files. When the user clicked
on a type 19 file, it reloaded all the database files again, plus the contents of the BP
file. BDT also reloaded all files whenever a file was opened for editing. This caused
users to have to navigate to the correct file in the Resource view repeatedly, and
made it difficult to see which file was open. This behavior has changed and BDT
now synchronizes the files as they load, as long as they are regular files. This issue
has been resolved.

UDBT-1787 The syntax highlighter in the BASIC Developers Toolkit did not recognize some
Universe-specific commands such as bscan in the October 2013 release. The failure
to recognize such commands caused errors to be erroneously reported. This issue
is resolved.

UDBT-1820 Prior to this release, when using the SUBR function on a subroutine that has
0 arguments the following error was generated. Function 'SUBR' requires 0
arguments. Number of arguments doesn't match. If the subroutine had two
arguments, the error appeared twice. This issue have been resolved.

UDBT-2050 After performing an Eclipse Tools update for BDT from the U2 Tools update
website using the October 2013 version of BDT (3.1.0), any attempt to use the
debugger failed to execute. This issue is now fixed.

UDBT-2175 Prior to this release, the BDT BASIC editor did not show the contents of the local
subroutines in the outline view. The main routine and calls to the local subroutines
were visible, but none of the information in the local subroutines was displayed.
This issue has been resolved.

U2 Basic Developer Toolkit 3.1.2
These release notes provide information about fixes in Basic Developer Toolkit (BDT).

Build: 2082
Release Date: January 2014

Fixes in U2 BDT 3.1.2

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-346 Prior to this release, some BDT users found that when they created a Basic
program containing an INCLUDE statement, the Outline view did not show all
variables. The Outline view now shows the correct information. This issue is
resolved.

UDBT-528 An enhancement has been added to BDT to have open programs autosave
to client-side storage. The default value is 5 minutes. To change the interval,
navigate to Window > Preferences > UniData/UniVerse > U2 Basic > Editor >
Editor automatic save interval, and then select the desired time. If BDT crashes
unexpectedly, the next time the user navigates to the same program on the server,
a merge request will be displayed. This autosave feature does not autosave the
server-side version of the program, only the client-side version.
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Issue Number Description

UDBT-581 An enhancement has been made to BDT that allows users to create new programs
and files from the menu. Previously, users could only add information by
navigating to the correct location in the U2 Resource view. Users can now create a
new file or program by selecting the File > New menu option.

UDBT-626 Prior to this release, when users navigated to Window > Preferences > General >
Editors > Text Editors, set the Displayed tab width to a value, and then selected
the Insert spaces for tabs option, an extra space was inserted. Now, when a user
selects the Insert spaces for tabs option, the correct number of spaces are used.
This issue is resolved.

UDBT-996 Beginning at this release, BDT now supports UniData 64-bit files and the Type 3
hash type. The CREATE.FILE syntax has a new 32BIT or 64BIT option for both static
and dynamic files. If no option is specified, the 32-bit option is selected by default.
The UDT 7.4 create.file syntax is:

CREATE.FILE [DICT | DATA] [DIR | MULTIFILE | MULTIDIR] filename [,subfile][modulo
[,block.size.multiplier]] [TYPE [0 | 1 | 3] [DYNAMIC [KEYONLY | KEYDATA] [PARTTBL
part_tbl]] [RECOVERABLE] [OVERFLOW] [64BIT|32BIT]

UDBT-1308 Prior to this release, each time a program was run in BDT's U2 Debug Terminal,
if the user did not enter "QUIT" in the terminal session, a database connection
remained active in addition to the BDT connection, as well as an additional license
consumed. Beginning at this release, a Maximum number of sessions field is
included in the U2 server advanced properties page. When the number of sessions
exceeds this limit, older sessions are terminated automatically. By default, this
number is 0 (zero), meaning there's no limit on the number of sessions.

Additionally, in the U2 Debug Terminal, a new Pin button has been added. When
the connection is pinned, the terminal is not removed automatically. This issue has
been resolved.

UDBT-1471 Starting at this release, the Basic Developer's Toolkit can communicate with
CVS or SVN repositories. The BDT tool can only verify the status of text oriented
documents on the U2 Servers (Basic programs, XML documents, etc.). With this
change there are three new icons that can appear on the bottom right of items in
the U2 Resource view. These are:

▪ * (Asterisk) - Server/Item is tracked via a source code control system

▪ ? (Question mark) - Current status of item is unknown

▪ Classic Database cylinder graphic - Item is in sync with source system
UDBT-1810 Beginning at the March 2013 release, an error message was seen in BDT every

time a user ran a RELEASE command. This was caused by an error parsing the ON
ERROR clause and has been fixed. This issue is resolved.

UDBT-1826 Beginning at this release, the Use fast loading method to load database file list
check box has been to the Advanced page in the U2 Server Properties wizard.
When the box is selected, BDT will initially only load the file names of a selected U2
server. If the check box is not selected, all of the database information, including
file type, is loaded with the file name.

For performance reasons, the default setting for this option is On.

U2 Basic Developer Toolkit 3.1.1
These release notes provide information about fixes in Basic Developer Toolkit (BDT).

Build: 2054
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Release Date: November 2013

Fixes in U2 BDT 3.1.1

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-1708 Incorrect folding and gray text was displayed if a user included the MACHINE.NAME
record of the UNIVERSE.INCLUDE directory in a program. This behavior was seen
in both the individual file or if the file was included in custom programs. The BDT
editor now works as expected with the MACHINE.NAME include file and any of the
other programs listed in the UNIVERSE.INCLUDE directory. This issue is resolved.

UDBT-1767 Prior to this release, when AE saved/wrote a Basic program it appended a CRLF to
each line. When BDT saved/wrote a Basic program, it appended an LF to each line
except the last, which was appended with a CRLF. The behavior of BDT has been
updated. Now, BDT uses an LF line delimiter for UNIX text files, and a CRLF line
delimiter for Windows text files. This issue has been resolved.

U2 Basic Developer Toolkit 3.1.0
These release notes provide information about fixes in Basic Developer Toolkit (BDT).

Build: 2025
Release Date: October 2013

Fixes in U2 BDT 3.1.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-1565 Prior to this release, BDT erroneously reported an error when using the INMAT
function with a parameter included. The code editor no longer reports an error
when valid syntax is used. This issue has been resolved.

UDBT-1369 Beginning at this release, BDT provides XML support for U2 Dynamic Objects.
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Issue Number Description

UDBT-1367 The following BASIC functions have been added to BDT:

▪ Audit logging

▫ AuditLog

▪ XML

▫ XDOMGetChildNodes

▫ XDOMGetElementById

▫ XDOMGetElementsByName

▫ XDOMGetElementsByTag

▫ XDOMItem, XDOMLength

▫ XDOMQuery

▪ UDO

▫ UDOArrayAppendItem

▫ UDOArrayDeleteItem

▫ UDOArrayGetItem

▫ UDOArrayGetNextItem

▫ UDOArrayGetSize

▫ UDOArrayInsertItem

▫ UDOArraySetItem

▫ UDOClone

▫ UDOCreate

▫ UDODeleteProperty

▫ UDOFree

▫ UDOGetLastError

▫ UDOGetNextProperty

▫ UDOGetOption

▫ UDOGetProperty

▫ UDOGetPropertyNames

▫ UDOGetType

▫ UDOIsTypeOf

▫ UDORead

▫ UDOSetOption

▫ UDOSetProperty

▫ UDOWrite

A full description of these functions can be found in the UniBasic Commands
Reference manual.

UDBT-1432 Prior to this release, the help dialog could not be moved or resized, which caused
some users to be unable to see the code window at the same time they were
looking at the help. The help dialog is now movable and resizable, allowing the
dialog to be placed anywhere on the desktop. This issue has been resolved.
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Issue Number Description

UDBT-1012 Beginning at this release, BDT provides support of local functions and subroutines
for UniVerse BASIC.

U2 Basic Developer Toolkit 3.0.5
These release notes provide information about fixes in Basic Developer Toolkit (BDT).

Build: 1099
Release Date: March 2013

Fixes in U2 BDT 3.0.5

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-1148 Prior to this release, BDT did not perform as expected when it encountered a
percentage sign (%) in the variable name. This issue has been resolved.

U2 Basic Developer Toolkit 3.0.4
These release notes provide information about fixes in Basic Developer Toolkit (BDT).

Build: 1080
Release Date: November 2012

Fixes in U2 BDT 3.0.4

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-1112 A fix has been made to the U2 Basic Program Options feature to allow users of
UniData 7.1 and earlier to override of the default compilation style under certain
scenarios. This fix only applies to UniData connections.  For UniData 7.2 and later,
users must specify the BASICTYPE in the initial resource view connection.

U2 Basic Developer Toolkit 3.0.3
These release notes provide information about fixes in Basic Developer Toolkit (BDT).

Build: 1069
Release Date: September 2012
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Fixes in U2 BDT 3.0.3

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-1102 Prior to this release, BDT did not recognize numbers in labels if the numbers were
followed by an asterisk (*) symbol. This issue applied to UniData only and has been
resolved.

UDBT-1120 BDT failed to launch the Debug perspective when users selected the Direct Debug
option in a Basic program. This issue applied to UniData only and has been
resolved.

U2 Basic Developer Toolkit 3.0.2
These release notes provide information about fixes in Basic Developer Toolkit (BDT).

Build: 1061
Release Date: July 2012

Fixes in U2 BDT 3.0.2

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-332 Prior to this release, users could not expand or collapse (code fold) UniData or
UniVerse code blocks that contained $IFDEF or $IFNDEF commands.  Now, the
code blocks can be used as expected and a coloring option has been added for
unused $IFDEF and $IFNDEF code blocks. The default color is RGB(192, 192, 192)
and can be changed in the preferences page. This issue has been resolved.

UDBT-333 When users mouseover SQL functions in the BDT code editor, the hover help
details did not appear. The hover help now works as expected for all SQL functions
in both UniData and UniVerse. This issue is resolved.

UDBT-334 The BDT code editor threw warnings “WARNING: Variable 'S.WORKFILE' never
assigned a value” on SELECT statements in the style:

                SELECT F.WORKFILE TO S.WORKFILE

This issue has been resolved.
UDBT-335 Prior to this release, variables that were used in subroutine or function calls were

erroneously flagged as unassigned and displayed a warning. This is no longer a
problem.

UDBT-337 Prior to this release, the EXECUTE command was not fully supported in UniVerse.
This issue has been resolved.
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Issue Number Description

UDBT-338 In UniVerse accounts only, any form of the GET(ARG.) statement caused the
variable to be reported as never assigned. For example,

GET(ARG.) VAR1 GET(ARG.,2)
VAR2

This issue has been resolved.
UDBT-342 In the Basic Developer's Toolkit's edit window, if coding for the program contained

an asterisk (for example, when used in an arithmetic expression), the color coding
would be incorrect for comments on the following line. This issue has been
resolved.

UDBT-343 Prior to this release, the BDT parser did not recognize the syntax of the INSERT()
and REPLACE() commands correctly, causing an error to be thrown. This issue has
been resolved.

UDBT-347 Beginning at this release, hover help is now available for INCLUDE files.  The full
code for INCLUDE files can be seen in the hover help and focus can be gained using
the F2 key.

UDBT-349 Prior to this release, BDT did not correctly display the selected INDENT settings.
This issue has been resolved. This issue is related to UDBT-361.

UDBT-350 The FORMAT function (Ctrl +Shift + F) did not work correctly with the FIND and
FINDST statements. This occurred because the statements were not listed as
keywords that could start statements. These statements have now been added
as keywords. A new Preference page was also added (Window > Preferences>
UniData/UniVerse > U2 Basic > Editor >Formatting) that allows users to add new
keywords, as needed. This issue has been resolved.

UDBT-356 Prior to this release, SUBROUTINE statements that included split-line syntax with
comments were mistakenly highlighted as being incorrect. This issue has been
resolved.

UDBT-357 BDT did not correctly compile programs with INPUT syntax in the form of 'INPUT
PART.NUMBER,3_:'. The INPUT statement was not being handled as intended. This
issue has been resolved.

UDBT-358 An “Auto-Recompile” feature has been added to BDT, allowing for programs to be
automatically compiled prior to clicking the Run or Debug options.  A new item
has been added to the user Preferences that allows you to see a warning asking if
you want to save and compile your changes before debugging a project. To turn
this feature on or off, navigate to Window > Preferences > UniData/UniVerse >
U2 Basic > Computer and select/deselect Save and compile any unsaved files
before debugging. By default, this feature is set to On.

UDBT-360 Prior to this release, EQUATE and COMMON variables had no syntax highlighting.
  Syntax highlighting has been added for EQUATE and COMMON variables and
users can now assign specific colors. The default color for EQUATE code blocks is
RGB(192, 192, 192) and the default color for the COMMON code block is RGB(128,
128, 192). Both can be changed from the preferences menu. This issue has been
resolved.

UDBT-361 Prior to this release, BDT did not correctly display the selected MARGIN settings.
This issue has been resolved. This issue is related to UDBT-349.

UDBT-362 On the file creation dialog, support for input of the LARGE.RECORD percentage has
been added.

UDBT-484 In BDT, the EXECPRE/XPRE programs correctly did not block the use of  X_CODE
54(WriteDIRRecord). The EXECPRE/XPRE program was called and when it returned
to the BDT client, it displayed the error and also allowed a record to be written.
This issue has been resolved.
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Issue Number Description

UDBT-487 Prior to this release, right-clicking on a variable in the code editor window and
selecting “Inspect” threw the message “The active frame cannot be located.”  This
problem has been resolved and the “Inspect” option now allows variable contents
to be viewed.

UDBT-495 Prior to this release, BDT could not find the $INCLUDE file if it was contained in a
MULTIDIR file. This issue has been resolved.

UDBT-497 An enhancement has been made so that direct cataloged programs can be
accessed within BDT. Prior to this release, only local and global cataloged
programs could be accessed.

UDBT-527 Prior to this release, if multiple EQUATE variables were defined on a single line, the
following error was seen: “Expecting RPAREN, found ‘TO’”.  This issue has been
resolved.

UDBT-560 An enhancement has been made so that external subroutines can be accessed
from the Outline view. This issue is related to UDBT-569.

UDBT-569 Prior to this release, BDT was unable to locate the source code for cataloged
programs that were not previously opened via BDT.  BDT has been fixed to
correctly locate the source code for cataloged programs.  A new dialog box has
also been added to allow users to select the accounts to be searched for source
code.

UDBT-572 An enhancement has been made that allows users to set a Watch Variable flag in
the Debug perspective. You can access this feature from the right-click menu. This
flag is available in the Debug perspective only.

UDBT-576 Prior to this release, source code lookup would search in the currently open
account and then in all other accounts if code was not located in the current
account.  An enhancement has been made to allow users to limit the accounts to
be searched based on a configurable dialog.  This issue is related to UDBT-569.

UDBT-612 Prior to this release, in UniData only, BDT did not support the ENTER statement in
UNIBASIC. This issue has been resolved.

UDBT-696 In earlier releases the BDT debugger was limited in the scope it had for inspection
of equated variables from INCLUDE files.  This enhancement allows direct
inspection of equated variables in the BDT debugger without opening the INCLUDE
file.

UDBT-950 When launching the BDT attach debugger to attach to a running UniVerse process,
all background processes were not listed.  This fix allows the BDT debugger
process listing to match the listing shown by UniVerse PORT.STATUS.

UDBT-1065 Prior to this release, BDT did not recognize UniData UniObjects server-side
processes as background processes. This issue has been resolved.

U2 Basic Developer Toolkit 3.0.1
These release notes provide information about fixes in Basic Developer Toolkit (BDT).

Fixes in U2 BDT 3.0.1

Build: 1043
Release Date: March 2012

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.
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The following issues were fixed in this release:

Issue Number Description

UDBT-592 The U2 Basic Developer Toolkit Help is available in V3.0.1. You can access it from
the U2 BDT main menu by selecting Help > Help Contents. We plan to add content
iteratively in this Help system in future releases of U2 DBTools.

UDBT-807 Support for UDO functions in BDT has been added at this release.

Basic Developer Toolkit 3.0.0
These release notes provide information about fixes in Basic Developer Toolkit (BDT).

Fixes in BDT 3.0.0

Build: 1022
Release Date: January 2012

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-336 The Compare option, which allows users to compare two programs with each
other, quit working and failed to find the differences between the programs. This
was due to a regression. This has been fixed and the Compare feature now works
as expected.

UDBT-339 Prior to this release, if you created a file name that began with a Microsoft-reserved
word, such as CON.TEST, BDT would allow you to create the file, which would then
throw an error message. BDT now checks to see if new file names begin with a
reserved word and does not allow you to proceed if a reserved word is used.

UDBT-364 Prior to this release, when a program was printed from BDT there were no
line numbers included in the print out. Beginning at this release, the program
information includes line numbers.

UDBT-368 Beginning at this release, device licensing can be used when launching run/debug
sessions of BASIC programs. A “Use Device License” checkbox has been added to
the advanced settings section for server connections.  With this checkbox selected,
run/debug sessions will not consume extra database licenses when run from the
same server connection. Note that device licensing does not apply to subsequent
connections through the Resource View, only to run/debug sessions on the same
connection.

UDBT-369 Some users found that when they attempted to debug a BASIC program through
BDT and clicked Step Over to advance to the next step, the debugger would hang.
This occurred on machines connected to a Windows 2008 server. This issue has
been resolved.

UDBT-371 Prior to this release, the @IDX.IOTYPE variable was not recognized as a valid
variable in the BDT editor. This issue has been resolved.

UDBT-378 In BDT, the debugger only allowed access on the default Port 23, which did not
allow for Secure Shell (SSH) port support. SSH port support is now available in
BDT. This issue is resolved.
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Basic Developer Toolkit 1.2.4
This Readme provides information about fixes in Basic Developer Toolkit (BDT).

Fixes in BDT 1.2.4

Build: 7444
Release Date: May 2011

The following issues were fixed in this release:

Issue Number Description

UCC-164 Specific instances of valid syntax, such as using @VM in code, or LOOP/REPEAT,
caused “unexpected token” errors in the BDT code editor. These errors have been
resolved.

UCC-165 BDT displayed warnings in the code editor when scientific notation was used. 
These warnings have been removed and BDT now has full recognition of scientific
notation.

UCC-174 BDT has been updated to allow the use of the variable name "KEY" without causing
errors.

UCC-217 Creating a file through U2 Resource View caused extra data to appear in
dictionaries when used with PICK accounts.  This problem was fixed and
enhancements were made to the dictionary editor to accommodate custom
dictionary items and to support A-/S-type attributes.

UCC-233 Errors found when using a comma with the DISPLAY command were only
appearing in the margins of the code editor window.  These errors are now
displayed in the U2 Problems tab.

UCC-252 Offline programs now display a "Read-only" tag at the bottom of the editor pane
upon opening BDT. When a user clicks the tab of a program, the icon changes to
show that it is offline. The text of the program is not editable.  A connection to the
server must be made to gain an editable version of the program.

UCC-400 Using #INCLUDE in a BASIC program would show errors in the BDT code editor.
  The behavior of #INCLUDE has been changed to match that of $INCLUDE in the
BDT code editor and errors no longer appear.

UCC-871 Some specific usage of the EQU syntax caused BDT to hang when opening
programs.  BDT has been fixed to successfully open programs containing EQU
syntax.

UCC-908 Preferences modified under the Window > Preferences menu were not being
saved in BDT.  This problem has been resolved at version 1.2.4.

UCC-915 U2 Eclipse-based tools have been updated to improve the file loading performance
in the U2 Resource View.  Full information for each file or program is loaded on-
demand only.  For nodes potentially containing a large amount of data, a pop-
up window has been added that allows users to apply detailed pattern matching.
  This feature allows users to see only those files of interest and to significantly
reduce the load time.  Paging may be enabled and page size configured in Window
> Preferences > UniData/UniVerse > U2 Resource View.

UCC-924 When a * (comment) was contained on a line after code, the code was highlighted
incorrectly in the code editor.  The problem has been fixed. The code portion is
now marked correctly in black and the comment is highlighted in green.
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Issue Number Description

UCC-930 After performing a refactor operation on a program, the BDT code editor was not
marked to show updates and changes were not being saved to the server.  This
problem has been resolved. The code editor is now marked dirty after a refactoring
operation.

UCC-932 The BDT Debugger was unable to show the values of watched variables after
stepping into subroutines.  This problem has been resolved.

UCC-949 Users can now extend server-side code for BDT by cataloging XTOOLSUB_XPRE
and XTOOLSUB_XPOST (XTOOLSUB_EXECPRE and XTOOLSUB_EXECPOST
respectively for UniData) to report connection errors back to the user interface.

UCC-959 Using the refactor option to rename a variable to a numeric value caused error
"not a valid Basic identifier."  With this fix, variables may now be refactored
successfully to numeric values.

UCC-960 Using the refactor option to rename a variable to a previously-existing name
caused error "not a valid Basic identifier."  With this fix, variables may now be
refactored successfully to existing names.

UCC-965 and
UCC-166

The "Format" option in BDT was not working correctly for all code structures such
as OPEN and WRITE code blocks.  This option has been fixed to properly format all
code structures in the code editor window.

UCC-970 Attempting to open a program in BDT when that program was already opened in
another editor caused the error 'Could not find basic program "xxxxx" in account
"xxxxx" on server "xxxxx".'  The ability to detect the lock and display the message
"Program xxxx is currently locked by user xxx" has been added at this version of
BDT.

UCC-971 Opening programs containing an asterisk (*) in the ID caused an error similar to
"Resource '/local-UV/HS.SALES/Database Files/BP/TEST*PROGRAM.uvbp' does not
exist."  This problem has been resolved.

UCC-977 In UniVerse BASIC, the XTOOLSUB subroutine now contains the SetRCPToolName
(67) parameter that reports which Eclipse tool called the subroutine. Valid values
are xmlbd, eda, wsd, xadmin, and bdt.

UCC-980 BDT now has the option to disable in-line compilation and syntax checking. To
toggle this option, set the value for "Check syntax automatically during editing" in
Windows -> Preferences -> UniData/UniVerse -> U2 Basic -> Compiler.

UCC-1003 When expanding files or programs in U2 Resource View, result sets with more than
one page of data would only display the first page even when switching pages. 
This problem is fixed and pages change upon selection from the page drop-down
box.

UCC-1019 Using bookmarks or tasks to open programs in BDT caused stale versions of
programs to be opened after connect/reconnect. This fix opens programs
according to an optimistic locking model, as follows:

1) If the server is not connected, a bookmark or task will bring up the editor with
locally-cached content and the file can not be edited. An icon appears to indicate
the file is read-only.

2) If the server is connected and the file has not been previously opened, a
bookmark or task will open the editor with fresh content from the server. If the file
was previously opened, the editor will use the cached version. When saving the file,
optimistic locking will be used. If the file had been changed on server side while
editing, a warning message will be displayed.

UCC-1028 The BDT dictionary editor caused corruption of dictionary attributes when used
with PICK-flavored UniVerse accounts.  This problem has been resolved in version
1.2.4.
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Issue Number Description

UCC-1039 Running programs using the BDT "Run Basic Program" option against UniData
servers caused BDT to hang.  This problem has been resolved and BASIC programs
may now be run against UniData servers.

UCC-1046 A pop-up window allowing users to apply detailed pattern matching in the U2
Resource View has been added.  This feature allows users to see only those files of
interest, and to significantly reduce the load time required in accounts containing
a large number of files or programs. 

UCC-1124 In order to hide internal files used by SQL conversions, the filter used to hide
internal and system files from the "Database Files" section in U2 Resource View has
been updated to include a filter for names ending in "_SQLDEF".

UCC-1147 Items imported into dictionaries using the import option in the dictionary editor
were not being saved. This problem has been fixed so that all imported items,
along with any other dictionary changes, are saved.

Basic Developer Toolkit 1.2.1
This Readme provides information about fixes in the Basic Developer Toolkit (BDT).

Fixes in BDT 1.2.1

Release Date: June 2010

The following issues were fixed in this release:

Issue Number Description

UCC-49 Beginning at this release, the U2 Basic Developer toolkit now supports multilevel
files.

Basic Developer Toolkit 1.1.3
This Readme provides information about fixes in the Basic Developer Toolkit (BDT).

Fixes in BDT 1.1.3

Release Date: September 2009

The following issues were fixed in this release:

Issue Number Description

11471 Beginning at this release, you can create type 1, type 19, and type 25 files from the
Basic Developer Toolkit.

11558 For UniVerse BASIC programs from a PI/Open-flavored account, labels and
variables are now case-insensitive in the Basic Developer Toolkit by default.

11562 Prior to this release, the Basic Developer Toolkit incorrectly checked code within
an $IFDEF or $IFNDEF statements. This code is no longer checked.
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Issue Number Description

11651 When using the Basic Developer Toolkit, using @ID in a program returned the
following error:

 "expecting IDENT, found '@ID'"

Changing @ID to ID eliminated the error. This problem has been fixed.
11652 If you displayed an error or warning the the Basic Developer Toolkit window, then

clicked F2 to focus the window, and then started another application, the focused
window displayed on top of the application you just started. This problem has
been fixed.

11653 If a multiline EQU statement appeared in a program, the Basic Developer Toolkit
returned an "unexpected token at the end of this line" message on the first line,
and "unexpected token: TO" on each additional line. This problem has been fixed.

11656 Before this release, the Basic Developer Toolkit produced "unexpected token"
errors when using the call or CALL statement. This problem has been fixed.

11673 Prior to this release, debugging a background phantom process or an interactive
phantom process did not work on UNIX platforms. This problem has been resolved.

11774 The Basic Developer Toolkit may have hung when using the colon (":") and
ampersand ("&") characters. An error was written to the client-side log. This
problem has been fixed.

38321 When editing properties in the Advanced Connection Details dialog box, the Basic
Developer Toolkit did not remember the password, even though "Remember Me"
was selected. This problem has been fixed.

38700 If a comment appeared within IF/THEN statements, unexpected errors occurred,
including an unexpected end-of-file. This problem has been resolved.

39848 When using the debugger, you can now update variable values from the main
screen, rather than having to enter subscreens.

38978 Prior to this release, the Basic Developer Toolkit was unable to open remote
INCLUDE files on UNIX platforms only.

39036 The Basic Developer Toolkit now supports the CRT/PRINT @(C,R) output statement
on Windows platforms.

39059 If you selected any UniVerse BASIC Program Options through the Basic Developer
Toolkit, the options were not saved the next time you opened the window. This
problem has been fixed.

39060 The Basic Developer Toolkit no longer displays error messages when using the ON
ERROR statement.

39105 Before this release, you could not open or create a UniVerse BASIC program in the
Basic Developer Toolkit if you were running in the PI/Open flavor. This problem has
been resolved.

39173 When using the Basic Developer Toolkit on UniVerse Windows platforms, you
would not attach to a process. This problem has been fixed.

39306 You can now create directory files through the Basic Developer Toolkit.
40344 On Linux platforms only, the following error message was displayed when trying to

execute a debug process:

"Can not attach debug line. Device name = tty"

This problem has been fixed.
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U2 EDA Replication Configuration Tool
The release notes in this section provide information about changes in the U2 EDA Replication
Configuration Tool.

The U2 EDA Replication Configuration Tool is an Eclipse-based tool used to replicate your data to a
SQL database, in addition to keeping your data safely stored in UniData. It allows you to store your
data in UniData while it is simultaneously replicated to Oracle, IBM DB2, or Microsoft SQL Server.
Use the replicated database for data-mining or reporting while you use UniData as your production
workhorse.

U2 EDA Replication Configuration Tool 4.83.0
These release notes provide information about fixes in the EDA Replication Configuration Tool.

Fixes in U2 EDA Replication Configuration Tool 4.83.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue number Description

UDBT-3141 Previously, when using the EDA Replication Configuration Tool to configure
replication, 82 was not an available option in the Version drop-down menu. This
issue has been resolved.

U2 EDA Replication Configuration Tool 4.82.0
These release notes provide information about fixes in the EDA Replication Configuration Tool.

Fixes in U2 EDA Replication Configuration Tool 4.82.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue number Description

UDBT-3043 Prior to this release, users were unable to create a new data source when using
the right-click menu options from the EDA Replication Configuration tool. Now,
users are able to create a new data source. Users are also able to create an EDA
Map Schema.

UDBT-3044 Previously, users who were converting replicated files to EDA files may have
experienced an error similar to the following:

Unable to access regroup1

This issue has been resolved.
UDBT-3050 Previously, when users ran file sync using the EDA Replication Config

tool, U2EDARepXCopy would compare with XTOOLSUB. A new
versionEDARepXCopy.txt file has been added so the U2EDARepXCopy
program can be verified without ties to the XTOOLSUB version.txt file.
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Issue number Description

UDBT-3054 Prior to this release, users may have experienced the following error when using
the EDA Replication Config tool to do replication:

Command failed at Subscribing Group

This issue has been resolved.

U2 EDA Replication Configuration Tool 4.81.0
These release notes provide information about fixes in the EDA Replication Configuration Tool.

Fixes in U2 EDA Replication Configuration Tool 4.81.0

There were no customer issues in this release. To see a list of fixes and new features common to all
Eclipse-based tools, see Shared components, on page 4.

U2 EDA Replication Configuration Tool 3.82.1
These release notes provide information about fixes in the EDA Replication Configuration Tool.

Fixes in U2 EDA Replication Configuration Tool 3.82.1

There were no customer issues in this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

U2 EDA Replication Configuration Tool 3.82.0
These release notes provide information about fixes in the EDA Replication Configuration Tool.

Fixes in U2 EDA Replication Configuration Tool 3.82.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-2172 Beginning at this release, 74 is an available option for UniData users in the
replication system definition.

UDBT-2174 Prior to this release, attempting to synchronize replication files in the EDA
Replication Configuration tool would cause the following error on dbresume
"dbresume: sh: -c: line 0: syntax error near unexpected token `/ud_repadmin."
This issue has been resolved.

U2 EDA Replication Configuration Tool 3.81.2
These release notes provide information about fixes in the EDA Replication Configuration Tool.

Build: 2082
Release Date: January 2014
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Fixes in U2 EDA Replication Configuration Tool 3.81.2

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 EDA Replication Configuration Tool 3.81.1
These release notes provide information about fixes in the EDA Replication Configuration Tool.

Build: 2054
Release Date: November 2013

Fixes in U2 EDA Replication Configuration Tool 3.81.1

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 EDA Replication Configuration Tool 3.81.0
These release notes provide information about fixes in the EDA Replication Configuration Tool.

Build: 2025
Release Date: October 2013

Fixes in U2 EDA Replication Configuration Tool 3.81.0

There were no customer issues in this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

U2 EDA Replication Configuration Tool 3.80.0
These release notes provide information about fixes in the EDA Replication Configuration Tool.

Build: 1043
Release Date: March 2012

Fixes in U2 EDA Replication Configuration Tool 3.80.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-616 Support for the EDA Replication Configuration Tool has been added at this release.
This tool is currently available for UniData only.
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U2 EDA Schema Manager
The release notes in this section provide information about changes in the U2 EDA Schema Manager.

U2 EDA Schema Manager is an Eclipse-based tool that allows users to create and manage schemas
for conversion of data stored in a U2 database to a first normal form database such as Microsoft SQL
Server.

U2 EDA Schema Manager 4.33.0
These release notes provide information about fixes in the EDA Schema Manager.

Fixes in U2 EDA Schema Manger 4.33.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue number Description

UDBT-3165 Prior to this release, the EDA Schema Manager would fail when virtual fields were
used. This issue has been resolved.

UDBT-3166 Beginning at this release, the dot SB/XA dictionary items will not be listed in the
EDA U2 File Dictionary list as they are not a valid field for the EDA Schema.

UDBT-3171 Beginning at this release, if EDA Create Schema fails, details of the failure will be
displayed in a dialog box.

UDBT-3237 UniData only. Prior to this release, V-type virtual fields would not display, but I-
type and dictionary fields would display correctly. This issue has been resolved.

UDBT-3241 Beginning at 4.2.0, users were unable to create new objects using the EDA Schema
Manager and could have seen an error message similar to the following:

Attribute Name should be one of the U2Fields

This error message was incorrectly displayed, as it should have only applied to
attributes. This issue is now resolved.

UDBT-3250 UniData only. Previously, EDA would not generate the correct SQL statement for
TRANS fields.

U2 EDA Schema Manager 4.32.0
These release notes provide information about fixes in the EDA Schema Manager.

Fixes in U2 EDA Schema Manager 4.32.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:



U2 EDA Schema Manager 4.31.0

31

Issue number Description

UDBT-3025 Previously, XTOOLSUB could have caused the EDA Schema Manager to overwrite
the EDAMAPSUB subroutine. XTOOLSUB has been updated. This issue has been
resolved.

U2 EDA Schema Manager 4.31.0
These release notes provide information about fixes in the EDA Schema Manager.

Fixes in U2 EDA Schema Manager 4.31.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue number Description

UDBT-2617 Beginning at the December 2015 U2 DBTools release, UniVerse users on version
11.3.0 or earlier could not use the EDAMAPSUB subroutine, as it no longer mapped
to the SQL Server DATETIME field correctly. This was caused by a server-side
enhancement that allowed users to map to the SQL Server 2008 DATE and TIME
fields.

Until SQL Server 2008, there was only a DATETIME field to which the UniVerse DATE
or TIME field would be mapped. SQL Server 2008 introduced the individual DATE
and TIME fields.

Beginning at this release for both UniVerse and the U2 DBTools, the EDAMAPSUB
subroutine will check the database version to determine how the mapping will
work.

For versions earlier than UniVerse 11.3.1, the UniVerse DATE and TIME will map to
SQL Server DATETIME field.

For UniVerse 11.3.1 and later, the UniVerse DATE and TIME will map to the SQL
Server DATE and TIME fields, respectively.

U2 EDA Schema Manager 3.32.1
These release notes provide information about fixes in the EDA Schema Manager.

Fixes in U2 EDA Schema Manager 3.32.1

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-2239 When the EDA Schema Manager was upgraded from the October 2013 version
to the August 2014 version on UniData version 7.3.6, the virtual fields would
disappear. This issue has been resolved.
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U2 EDA Schema Manager 3.32.0
These release notes provide information about fixes in the EDA Schema Manager.

Fixes in U2 EDA Schema Manager 3.32.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-1801 If you tried to create a new EDA Map Schema in the EDA Schema Manager, the
same file name was displayed twice when you clicked the file name. This issue is
resolved.

U2 EDA Schema Manager 3.31.2
These release notes provide information about fixes in the EDA Schema Manager.

Build: 2082
Release Date: January 2014

Fixes in U2 EDA Schema Manager 3.31.2

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-1669 An enhancement has been made to EDA that allows users to alter or change
existing schemas without having to reload the existing tables. The GUI tool now
contains an EDA Alter button. Now a user can add an attribute to the EDA Schema
in the editor and then click Convert > EDA Alter and the new attribute will be
appended to the table without the table having to reload.

UDBT-1822 Prior to this release, when an unmapped block was set to 0, the Whole Record and
Nonconforming Record fields were not set to No, the settings were not saved.
EDA now checks to make sure that all fields are set appropriately and saves the
changes when the settings are correct. This issue is resolved.

U2 EDA Schema Manager 3.31.1
These release notes provide information about fixes in the EDA Schema Manager.

Build: 2054
Release Date: November 2013

Fixes in U2 EDA Schema Manager 3.31.1

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.
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The following issues were fixed in this release:

Issue Number Description

UDBT-923 Prior to this release, users could not map PICK-style DICT items to SQLServer
with TRANS or DATA type in the Schema mapping tool. Now, the TRANS and DATA
types map as expected. For existing schema maps, ensure the TRANS fields have
attribute type "TRANS" instead of "DATA. This issue has been resolved.

UDBT-1233 Prior to this release, the attributes in the DDL create table statement were not
sorted by dictionary order. This made it difficult for users to find a particular
attribute, especially in cases when the primary key needed to be the first column in
a table. Beginning at this release, fields in the schema map are saved in dictionary
location order by default. Users can also choose other sorting options by right-
clicking on the schema map. This issue is resolved.

UDBT-1235 An enhancement has been made to the EDA Schema Manager tool so that when a
UniData file is converted, the owner and group permissions do not get changed,
but instead keep the permissions from the original permissions on the file.
However, only the administrator (root on UNIX, or udadm users) can retain the
owner/group information. If a non-root user converts the file, the new file will have
this user's owner/group information.

UDBT-1669 An enhancement has been made to EDA that allows users to alter or change
existing schemas without having to reload the existing tables. The GUI tool now
contains a "EDA Alter" button. Now a user can add an attribute to the EDA Schema
in the editor and then click Convert > EDA Alter and the new attribute will be
appended to the table without the table having to reload.

U2 EDA Schema Manager 3.31.0
These release notes provide information about fixes in the EDA Schema Manager.

Build: 2025
Release Date: October 2013

Fixes in U2 EDA Schema Manager 3.31.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see the Shared
components, on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-1481 In the EDA Schema Manager tool, the data type for the @ID location field was
incorrectly set to DATA. The data type for the @ID field is now set to ID DATA and
working as expected. This issue is resolved

UDBT-1480 Prior to this release, SQL column names could not exceed 30 characters in length
against SQL Server. This has been changed and the SQL column names now have a
60 character limit when using EDA connections to SQL Server. This issue has been
resolved.

UDBT-1478 Prior to this release, users could not create an EDA schema map if certain special
characters, such as an ampersand (&) were contained in field 4. EDA Schema
Manager now allows for the following special characters: &, <, > and ". This issue
has been resolved.
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U2 EDA Schema Manager 3.30.1
These release notes provide information about fixes in the EDA Schema Manager.

Fixes in U2 EDA Schema Manager 3.30.1

Build: 1043
Release Date: March 2012

There were no customer issues at this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

EDA Schema Manager 3.30.0
These release notes provide information about fixes in the EDA Schema Manager.

Fixes in EDA Schema Manager 3.30.0

Build: 1022
Release Date: January 2012

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-27 Some AIX UD 7.2.8 and HPUX UD 7.2.x users who tried to create an EDA data source
name against the server saw the following error: “Failed to open file EDA_DATA”.
This issue has been resolved.

EDA Schema Manager 1.2.3
These release notes provide information about fixes in the EDA Schema Manager.

Fixes in EDA Schema Manager 1.2.3

Build: 7444
Release Date: May 2011

The following issues were fixed in this release:

Issue Number Description

UCC-1104 In EDA Schema Manager, the EDA Map menu option “EDA Scripts” was changed to
“Get DDL Scripts” to more accurately reflect the behavior of this menu option.
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U2 Metadata Manager
The release notes in this section provide information about changes in the U2 Metadata Manager.

The U2 Metadata Manager is an Eclipse-based, client-side tool used to make changes to the U2
database servers. It allows users to better describe the type of data stored in each location of their
data files and is also used to define first normal form exposure.

U2 Metadata Manager 4.73.0
This release note provides information about fixes in the U2 Metadata Manager.

Fixes in U2 Metadata Manager 4.73.0

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 Metadata Manager 4.72.0
This release note provides information about fixes in the U2 Metadata Manager.

Fixes in U2 Metadata Manager 4.72.0

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 Metadata Manager 4.71.0
This release note provides information about fixes in the U2 Metadata Manager.

Fixes in U2 Metadata Manager 4.71.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue number Description

UDBT-2733 Prior to this release, changing a table name in MDM deleted information from the
_METADATA_REPOSITORY_ file. This has now been resolved

U2 Metadata Manager 3.73.1
This release note provides information about fixes in the U2 Metadata Manager.

Fixes in U2 Metadata Manager 3.73.1

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:
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Issue Number Description

UDBT-2186 In previous versions, when there was a large number of attributes selected for the
virtual and 1NF attributes, and it produced a string larger than the U_SENTLEN
limit (maximum sentence length) in UniData, an error occurred. Now, an error
displays if the length of the string of the selected attributes exceeds the limit of
9247.

U2 Metadata Manager 3.73.0
This release note provides information about fixes in the U2 Metadata Manager.

Fixes in U2 Metadata Manager 3.73.0

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 Metadata Manager 3.72.2
This release note provides information about fixes in the U2 Metadata Manager.

Build: 2082
Release Date: January 2014

Fixes in U2 Metadata Manager 3.72.2

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 Metadata Manager 3.72.1
This release note provides information about fixes in the U2 Metadata Manager.

Build: 2054
Release Date: November 2013

Fixes in U2 Metadata Manager 3.72.1

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 Metadata Manager 3.72.0
This release note provides information about fixes in the U2 Metadata Manager.

Build: 2025
Release Date: October 2013
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Fixes in U2 Metadata Manager 3.72.0

There were no customer issues at this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

U2 Metadata Manager 3.71.0
This release note provides information about fixes in the U2 Metadata Manager.

Build: 1099
Release Date: March 2013

Fixes in U2 Metadata Manager 3.71.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-1325 Some users found that the scroll bar did not always stay in a fixed position when
choosing alternate fields in the U2 MDM wizard. This issue has been resolved.

UDBT-1322 Some UniVerse users found that the U2 MDM schema tool reported stale schema
on the server when the schema was not stale. This issue has been resolved.

UDBT-1290 Prior to this release, if a user ran U2 MDM on the Demo account and then
uninstalled and reinstalled UniData, the METADATA_REPOSITORY file was
left in the Demo account. After re-installing UniData, the MDM tool would
encounter an issue when this occurred, because the VOC did not have the
METADATA_REPOSITORY file pointer, but the file system had the physical file. The
files now sync as expected. This issue is resolved.

UDBT-1259 Some users found that they could not open a new editor if the metadata editor was
already open for the same file. This issue has been resolved.

UDBT-1236 Prior to this release, Basic subroutines that were converted by U2 MDM did not
return all of the subtable information. This issue has been resolved.

UDBT-1150 Previously, the U2 MDM tool did not automatically create a schema after the
metadata/1NF map was created. Beginning at this release, users can select the
Create schema option as the final step of the wizard process. If this option is
selected, a new schema will be created when the wizard creates the new 1NF map.

UDBT-1145 Beginning at this release, the U2 Metadata Manager supports UniVerse 11.1.11 or
later.

UDBT-1031 When a table was opened in the graphical view of the U2 MDM editor, and a user
right-clicked on a field name to view the table properties, the dictionary field
properties did not display correctly. This issue has been resolved.

U2 Metadata Manager 3.70.2
This release note provides information about fixes in the U2 Metadata Manager.

Build: 1080
Release Date: November 2012
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Fixes in U2 Metadata Manager 3.70.2

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-1140 The U2 MDM tool has updated the way it selects the initial field that will represent
the attributes for a file. Fields with a data type other than VARCHAR and/or FMT
fields not set to 10 or L are given precedence over fields containing the default
settings.

UDBT-1131 Prior to this release, when a user created a new set of metadata using the U2 MDM
editor, a second, unused editor was also created. This second editor no longer
opens and the issue is resolved.

UDBT-1129 Prior to this release, the table graphics in the graphical editor used horizontal
scroll bars located on the bottom of each table representation, causing users to
have to scroll horizontally to view a vertical list. This has been changed, and the
table graphics now use the more standard right-side, vertical scroll bars. This issue
has been resolved.

UDBT-1125 In the U2 MDM wizard, users found that if they selected virtual fields and then
clicked Finish instead of Next, the virtual field selection would be lost. This did not
occur if the user selected Next and continued in the wizard to create the 1NF map
page. Users can now use the wizard to select virtual fields for their metadata files
without having to also create a 1NF map. This issue has been resolved.

UDBT-1119 Prior to this release, U2 MDM could not handle multiline error messages. This issue
has been resolved.

UDBT-1117 The U2 Metadata Manager's Schema Tools verify tab uses JDBC to connect to
the U2 databases. It uses the account name in the connection string. Prior to this
release, it used the account name, instead of the account path on the server.
This meant that the account name had to be located in the $UDTHOME/include/
ud_database file on the server. The JDBC connection now uses the fully specified
path instead, so that the account name no longer has to reside in the ud_database
file on the server.

UDBT-1106 Some users found that U2 MDM failed to load the field data from the repository.
When data saved in the _METADATA_REPOSITORY_ file was loaded, none of
the single-valued fields or containers would open. This occurred only when a
dictionary item contained an item with the same name as the data file. All data
now loads as expected. This issue has been resolved.

UDBT-1097 If a metadata repository record existed for a database file, but the database file/
dictionary was not present on the account, a Null Pointer Exception was thrown
when the user right-clicked on the file name in the "Metadata Repository" section
of the U2 Resource view. This occurred when a file was mapped and then later
deleted from the account. It also occurred when the data for the file was deployed
from the metadata repository to an account that did not contain the mapped
file's database file. These conditions no longer cause a Null Pointer Exception and
instead generate a regular error message explaining that metadata still exists for a
file even though the file itself is gone. This is also recorded in the Eclipse error log.
This issue has been resolved.

UDBT-1045 Prior to this release, some users found that the Schema tool would report that a
schema on the server was stale even when it was not stale. This issue has been
resolved.
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Issue Number Description

UDBT-1033 In the U2 MDM wizard, users found that if they made a virtual association selection,
clicked Next and selected some 1NF map attributes, clicked Back and deselected
one of the virtual attributes and then clicked Next again to continue, the virtual
field selection would be lost. This issue has been resolved.

UDBT-899 Prior to this release, users who attempted to use the schema tool against schemas
with VSG schema version 4000.00.01 that had not updated using the MIGRATE.SQl
command, saw the following unhelpful error: “Generation of the schema data on
the server failed for file: XXXX. Error code: –1. Can’t open UD_SQLTABLES”. Now,
users see a message that tells them they need to update the schema using the
MIGRATE.SQL command. This issue has been resolved.

U2 Metadata Manager 3.70.1
This release note provides information about fixes in the U2 Metadata Manager.

Build: 1050
Release Date: May 2012

Fixes in U2 Metadata Manager 3.70.1

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-937 The U2 Metadata Manager now supports virtual attributes for UniData accounts.
Note that data type enforcement is not supported for these virtual attributes.

UDBT-957 Prior to this release, some users found that under certain circumstances a file’s
record in the METADATA_REPOSITORY would become corrupt and could not
be opened in the U2 MDM editor. This occurred when a file that existed in the
metadata repository without any 1NF mapping was loaded into the U2 MDM editor
and a change was made in the metadata and then the file was saved without a 1NF
map. This issue has been resolved.

UDBT-976 When users attempted to use the Ctrl + click-and-drag feature to create a new
metadata file in the U2 MDM editor, a null pointer exception was thrown. This issue
has been resolved and users can now use this feature as expected.

UDBT-983 Prior to this release, you could not delete schema data. The U2 MDM editor now
allows you to clear the schema data from the repository, either by right-clicking
the file name in the U2 Resource view and then selecting Delete from the menu,
or by clicking the Delete button on the toolbar when the schema is open in the
schema editor. This issue has been resolved.

UDBT-1007 When users attempted to generate a schema on a dictionary file that contained
a Basic keyword in the multivalue association, the schema generation would fail.
Now, if a Basic keyword is used, U2 MDM adds an underscore to the end of the
reserved word. For example, if OCONV is used in the dictionary it is changed to
OCONV_ in the schema map. This issue has been resolved.

UDBT-1013 The U2 MDM tool now allows you to define the trace level for JDBC logging when
testing a schema.
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Issue Number Description

UDBT-1028 Tables based on multivalued associations cannot contain only virtual fields
and must contain at least one D-type field, in addition to the primary key. If this
situation occurs, an icon now appears next to the table name that warns the user
that a D-type field is required.

UDBT-1030 Prior to this release, some dictionary fields were sized incorrectly in the U2 MDM
editor. This issue has been resolved.

U2 Metadata Manager 3.70.0
This release note provides information about fixes in the U2 Metadata Manager.

Build: 1043
Release Date: March 2012

Fixes in U2 Metadata Manager 3.70.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-672 Support has been added for U2 Metadata Manager at this release. This tool is
currently available for UniData only.

UDBT-921 The U2 Metadata Manager Help is available in V3.70.0. You can access it from the
U2 MDM main menu by selecting Help > Help Contents. We plan to add content
iteratively in this Help system in future releases of U2 DBTools.
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U2 RESTful Web Services
The release notes in this section provide information about changes to the U2 RESTful Web Services.

U2 RESTful Web Services 4.63.0
These release notes provide information about fixes to U2 RESTful Web Services.

Fixes in U2 RESTful Web Services 4.63.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue number Description

UDBT-3201 In v4.3.0, U2 RESTful Web Services has been enhanced to allow MV Discover to
use database credentials to protect its REST API endpoints using HTTP Basic
authentication.

UDBT-3217 Previously, the RESTful Web Service Developer would display loopback scan
messages even if a user had not defined a service. This was caused by a Jetty
component that was added that scans a directory for configuration changes and
logs at the debug level each time it does a scan. This issue is resolved.

UDBT-3175 Prior to this release, a file with spaces in the IDs could be invalid because of the URI
that was created. This issue has been resolved.

U2 RESTful Web Services 4.62.0
These release notes provide information about fixes to U2 RESTful Web Services.

Fixes in U2 RESTful Web Services 4.62.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed at this release:

Issue number Description

UDBT-2903 Beginning at this release, any action that requires a write method such as PUT,
DELETE, or POST on a locked file record will now return an HTTP 409 error.

UDBT-2917 Previously, users were unable to open large dictionaries using the U2 Resource
view for RESTful Web Services. The following parameters were added to the
u2rest.ini file to increase Java memory:

-Xms40m

-Xmx1200m

This issue has been resolved.
UDBT-2955 Prior to this release, when creating or amending Access Control for a RESTful

web service after adding an HTTP user and selecting ANY ROLE and one or more
methods, users may have seen an HTTP Error 403 or a !role message. This occurred
on both data and subroutine services. This issue has been resolved.
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Issue number Description

UDBT-3000 Beginning at this release -Dloopbackonly=true can be added to the startup
script to change the IP address to 127.0.0.1. Changing the IP address to 127.0.0.1
enables only the local server to connect to any port that the web server has
enabled.

U2 RESTful Web Services 4.61.0
These release notes provide information about fixes to U2 RESTful Web Services.

Fixes in U2 RESTful Web Services 4.61.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed at this release:

Issue number Description

UDBT-2279 Previously, U2 WSD or U2 REST servers could not disable SSLv2 or SSLv3 due to
the use of Java 1.7 or lower. The current release has included Java 1.8 to allow the
disablement of these SSL versions, which are now disabled by default. To reenable
these SSL versions, the U2SOAP.config and U2REST.config files must be manually
modified to allow them.

UDBT-2602 Prior to this release, users could not deploy their RESTful web services when using
the generated deployment configuration file. This issue has been resolved.

UDBT-2744 Beginning at this release, the secure connection between a U2 REST or U2 SOAP
server will attempt to negotiate the highest possible security protocol to the U2
database automatically. SSLv3 is turned off automatically from any negotiation by
the latest JVM's.

U2 RESTful Web Services 3.62.1
These release notes provide information about fixes to U2 RESTful Web Services.

Fixes in U2 RESTful Web Services 3.62.1

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed at this release:

Issue Number Description

UDBT-1818 In previous versions, if more than 10 input fields were defined and tested on the
web service, an error occurred. This issue has been resolved.

UDBT-1817 In previous versions, when generating resources from a U2 file in U2 RESTful Web
Services Developer, if you selected a dictionary name that contained a backslash
character, the resource name reflected a change of the backslash character to an
underscore. When the U2 RESTful Web Services Developer server started up and
attempted to open that data resource, an HTTP 404 error would occur. This issue
has been resolved.
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U2 RESTful Web Services 3.62.0
These release notes provide information about fixes to U2 RESTful Web Services.

Fixes in U2 RESTful Web Services 3.62.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed at this release:

Issue Number Description

UDBT-1512 Beginning at this release, U2 RESTful Web Services uses and supports JRE 1.7
in the development and deployment environments. In order to use Java 7,
U2 RESTful Web Services was re-architected and no longer has a dependency
on Java Persistence API (JPA ) technology. In order to take advantage of the
newly architected U2 RESTful Web Services, you must first back up your existing
development environment, using the methods described in the U2 RESTful Web
Services User Guide. After backing up your files, follow the installation prompts
which will automatically convert any existing data resources and services to work
with the re-architected U2 RESTful web services.

Note:  The file conversion is a one-time process and cannot be undone. U2
recommends that you make a backup copy of these files before completing the
conversion process.

Warning:  The application must be tested in the development environment before
redeploying any U2 RESTful web services. Do not make any manual changes to the
generated files, as this may break the application.

UDBT-1876 Beginning at this release, users can modify the Java heap size for a Java virtual
machine when starting a REST server. This option can be utilized by navigating to
Window > Preferences > U2 RESTful Web Services Developer, and then selecting
Set Java heap sizes. This option is not enabled by default.

UDBT-1908 An enhancement has been made so that if U2 RESTful Web Services encounters an
INPUT parameter and the client have not passed anything in that parameter, then
it will fill that parameter with the IP Address of the request before calling the Basic
program with the data passed from the client.

UDBT-1914 Prior to this release, some users found that U2 RESTful Web Services would return
an empty JSON array when an association contained only one multivalued field.
This issue has been resolved.

UDBT-1938 Beginning at this release, when a new version of U2 RESTful Web Services is
installed users will see a message asking them to backup their files.

UDBT-1944 Prior to this release, U2 SOAP services and U2 RESTful web services could only be
deployed onto the C:\ drive. Users can now deploy the services on any drive. This
issue has been resolved.

U2 RESTful Web Services 3.61.2
These release notes provide information about fixes to U2 RESTful Web Services.

Build: 2082
Release Date: January 2014
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Fixes in U2 RESTful Web Services 3.61.2

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 RESTful Web Services 3.61.1
These release notes provide information about fixes to U2 RESTful Web Services.

Build: 2054
Release Date: November 2013

Fixes in U2 RESTful Web Services 3.61.1

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 RESTful Web Services 3.61.0
These release notes provide information about fixes to U2 RESTful Web Services.

Build: 2025
Release Date: October 2013

Fixes in U2 RESTful Web Services 3.61.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed at this release:

Issue Number Description

UDBT-1692 When a user tried to import the RESTful web services from a deployed package,
a duplicate copy of the server name was made in the U2 Resource view. Deleting
the duplicated copy also deleted the original server information. Importing web
services from the deployed package now works as expected. This issue is resolved.

UDBT-1640 Some users found that after a REST server has been exported, deployed and
installed on the target computer, the authentication type would reset to 'digest'
and could only be changed in the u2rest.config file. Users can now define or
change the authentication type both in the GUI tool and from the command line.
This issue has been resolved.

UDBT-1497 When users backed up U2 REST directories and then later attempted to restore
those directories on a new machine, duplicate server names were created in the U2
Resource view. Deleting these duplicated names deleted both the original server
and the duplicate. This issue has been resolved.

UDBT-1494 U2 RESTful Web Services now allows users to import the services developed in
one U2 RESTful Web Services Developer instance into another instance of the
Developer. This includes the ability to import, update, and merge the web services.
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Issue Number Description

UDBT-1444 Prior to this release, U2 RESTful Web Services did not support A-type or S-type
dictionaries when creating a REST server. Now, users can select the A-type and S-
type fields with correlatives and generate U2JPA classes that include these fields.
Two buttons have been added to the REST server wizard, Raise All MS to MV and
Raise All MS to S, that makes it easy for the user to specify the true S/M value for
the fields with only the M value specified.

UDBT-1443  Prior to this release, users could not easily select all S-type dictionary items. An
option has been added to the U2 REST developer that allows users to select all S-
type dictionaries when a PICK files is selected. This issue has been resolved.

UDBT-1366 When users created a data resource to a PICK-style account, they were unable to
select any dict items pointing to attribute 0 (ID). Users can now select dict items
located in attribute 0. This issue has been resolved.

U2 RESTful Web Services 3.60.7
These release notes provide information about fixes to U2 RESTful Web Services.

Build: 1114
Release Date: June 2013

Fixes in U2 RESTful Web Services 3.60.7

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed at this release:

Issue Number Description

UDBT-1379 When input string parameters were left blank in a RESTful subroutine service, the
subroutine would crash with a Server 500 error. This issue has been resolved.

UDBT-1440 Prior to this release, if multiple associations were used out of sequence in the U2
REST subroutine resource, the resource would fail with a Server 500 error. This was
only seen if an association was referenced multiple times out of sequence. This
was caused by a mapping error in the dynamic array. This issue has been resolved.

U2 RESTful Web Services 3.60.5
These release notes provide information about fixes to U2 RESTful Web Services.

Build: 1099
Release Date: March 2013

Fixes in U2 RESTful Web Services 3.60.5

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed at this release:
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Issue Number Description

UDBT-1230 Prior to this release, from the Edit Resource Folder page in the U2 REST resource
wizard, users could not change the name of the server to which they were
attempting to connect. Now, both the name of the account and the name of the
server can be changed in the wizard. This issue is resolved.

UDBT-698 Prior to this release, U2 REST did not provide the functionality needed to register a
REST server as a service, preventing the services from being started automatically.
Beginning at this release, users can start and stop a REST server as a service. To
start the REST server as a service:

U2restservice.exe –i u2rest-server-name [-s u2rest-service-name] [-d u2rest-
service-description]

The default value for -s is u2rest-server-name. The default value for –d is “U2
RESTful service to start and stop U2 REST server”. After you install the service
you can start or stop the u2rest-server-name as a Windows service from the
Windows control panel. When you start the service it executes ‘runrestserver.bat
u2rest-server-name’ and waits until this bat file exits. When you stop the service,
it executes ‘stoprestserver.bat u2rest-server-name’. You can pass additional
arguments to runrestserver.bat by specifying the start parameters to the service.

To remove the U2 REST server as a service:

U2restservice.exe –r u2rest-server

Detailed instructions on deploying a U2 REST server as a service can be found in U2
RESTful Web Services Help.

U2 RESTful Web Services 3.60.4
These release notes provide information about fixes to U2 RESTful Web Services.

Build: 1080
Release Date: November 2012

Fixes in U2 RESTful Web Services 3.60.4

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed at this release:

Issue Number Description

UDBT-1179 The documentation for U2 RESTful Web Services is now included in the Eclipse
Help. To access the documentation from within the tool, select Help > Help
Contents from the Eclipse toolbar and then select U2 RESTful Web Services  from
the Contents list.

UDBT-700 A new subroutine parameter type, json, was added to the tool which allows the
U2REST server to interact with U2 Dynamic Object (UDO), which can be used to
consume and present the JSON object both to and from the subroutine, and will
ensure the correct JSON format is used. This issue has been resolved.

U2 RESTful Web Services 3.60.3
These release notes provide information about fixes to U2 RESTful Web Services.
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Build: 1053
Release Date: June 2012

Fixes in U2 RESTful Web Services 3.60.3

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed at this release:

Issue Number Description

UDBT-808 Beginning at this release, a New Dynamic Array menu item has been added to the
U2 REST Servers > Subroutine Resources > Dynamic Array Definitions context
menu. Prior to this, users could only create a new dynamic array by dragging it
from the U2 Resource view.  

UDBT-947 Users saw incorrect tool tips and menu options when defining new dynamic arrays
and subroutines. This issue has been resolved.

UDBT-963 Users who mapped a UniVerse multi-subvalue field in the U2 RESTful Web Services
developer and then renamed the resource found that this resulted in invalid,
duplicated names. This caused the resource to break and in some instances also
caused the U2 RESTful server to fail. This issue has been resolved.

UDBT-966 Prior to this release, you could not define multiple access control lists (ACLs) on
the same resource. For example, if you created an admin ACL for your POST, PUT,
and DELETE methods, you could not then define a restricted user role for the GET
method.  Users can now define multiple ACLs on the same resource. This issue has
been resolved.

UDBT-967 Prior to this release, in U2 RESTful Web Services, users found they could not keep
a persistent connection if they used the runstartserver.bat and runrestserver.sh
processes. These processes now start a RESTful Web server when called, solving
this problem.

UDBT-993 When users developed an SSL-enabled U2 RESTful Web service, the URI connection
property did not change from HTTP to HTTPS. Developers had to manually insert
the ‘s’ character. This issue has been resolved and the connection property now
automatically changes from HTTP to HTTPS.

UDBT-994 Prior to this release, users could not import or export any HTTP users or Access
Control properties from your U2 RESTful Web services. This issue has been
resolved.

U2 RESTful Web Services 3.60.2
These release notes provide information about fixes to U2 RESTful Web Services.

Build: 1045
Release Date: April 2012

Fixes in U2 RESTful Web Services 3.60.2

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed at this release:
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Issue Number Description

UDBT-948 If the data resource name was changed in U2 RESTful Web Services Developer,
restarting the service and attempting a connection caused an HTTP 500 error.  This
error was caused by .jar files associated with U2 RESTful Web Services Developer
versions not getting updated correctly.  This problem has been resolved in this
update.

U2 RESTful Web Services 3.60.1
These release notes provide information about fixes to U2 RESTful Web Services.

Build: 1043
Release Date: March 2012

Fixes in U2 RESTful Web Services 3.60.1

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed at this release:

Issue Number Description

UDBT-691 Some users encountered an XTOOLSUB ‘Base 64’ error instead of the appropriate
permission error when connecting to servers where an XTOOLSUB update was
required but permissions were insufficient to write the update. This issue has been
resolved. 

UDBT-709 Prior to this release, when a user created a new U2 RESTful resource, added a
subroutine to the resource without adding a data type, and then tried to export
that subroutine resource, the export would fail. This issue has been resolved and
U2 RESTful resources that contain only a subroutine now export as expected.

UDBT-908 When users defined a UniVerse or UniData data type field as either “MS” or “MV”,
U2 REST would incorrectly treat that data type as an “M” type. This issue has been
resolved.

U2 RESTful Web Services 3.60.0
These release notes provide information about fixes to U2 RESTful Web Services.

Build: 1022
Release Date: January 2012

Fixes in U2 RESTful Web Services 3.60.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed at this release:

Issue Number Description

UDBT-21 Support for U2 RESTful Web Services has been added at this release.
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U2 Web Services Developer
The release notes in this section provide information about changes in the U2 Web Services Developer
(WSD).

U2 Web Services Developer (WSD) allows you to create and deploy your Web Services applications,
and manage your SOAP servers. This is an Eclipse-based tool.

U2 Web Services Developer 4.23.0
These release notes provide information about fixes in the U2 Web Services Developer.

Fixes in U2 Web Services Developer 4.23.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue number Description

UDBT-3084 Prior to this release, the U2 SOAP services could only be deployed onto the C:\
drive. Users can now deploy the services on any drive.

U2 Web Services Developer 4.22.0
These release notes provide information about fixes in the U2 Web Services Developer.

Fixes in Web Services Developer 4.22.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue number Description

UDBT-2920 Beginning at the Dec2015 release, U2 Web Services Developer services would not
work with CORS requests. This was caused by an upgrade to the Jetty 9.x server.
This issue has been resolved.

UDBT-2922 Prior to this release, users would manually adjust rows when adding or deleting
a field in the Web Services Developer. Now, a dialog box opens to show that the
field is already in use and offers to move the new field to the requested location
and move up the location of the fields above the insertion. This issue has been
resolved.

U2 Web Services Developer 4.21.0
These release notes provide information about fixes in the U2 Web Services Developer.
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Fixes in Web Services Developer 4.21.0

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 Web Services Developer 3.22.1
These release notes provide information about fixes in the U2 Web Services Developer.

Fixes in Web Services Developer 3.22.1

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-2468 Prior to this release, on Linux there was a timeout issue when closing a socket
whose counterpart was already closed. This issue has been resolved with an
updated uoj.jar file.

UDBT-2440 Prior to this release, if connection pools were idle and the database had cleaned
up all connections, any SOAP request would fail with an error similar to:

asjava.uniobjects.UniSessionException: The connection is 
bad, and may be passing corrupt data

This issue has been resolved.

U2 Web Services Developer 3.22.0
These release notes provide information about fixes in the U2 Web Services Developer.

Fixes in Web Services Developer 3.22.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue number Description

UDBT-1557 Prior to this release, U2 SOAP services could only be deployed onto the C:\ drive.
Users can now deploy the services on any drive. This issue has been resolved.

UDBT-1876 Beginning at this release, users can modify the Java heap size for a Java virtual
machine when starting a U2 SOAP server. This option can be utilized by navigating
to Window > Preferences > U2 Web Services Developer, and then selecting Set
Java heap sizes. This option is not enabled by default.

UDBT-1944 Prior to this release, U2 SOAP services and U2 RESTful web services could only be
deployed onto the C:\ drive. Users can now deploy the services on any drive. This
issue has been resolved.
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U2 Web Services Developer 3.21.2
These release notes provide information about fixes in the U2 Web Services Developer.

Build: 2082
Release Date: January 2014

Fixes in Web Services Developer 3.21.2

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 Web Services Developer 3.21.1
These release notes provide information about fixes in the U2 Web Services Developer.

Build: 2054
Release Date: November 2013

Fixes in Web Services Developer 3.21.1

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 Web Services Developer 3.21.0
These release notes provide information about fixes in the U2 Web Services Developer.

Build: 2025
Release Date: October 2013

Fixes in Web Services Developer 3.21.0

There were no customer issues in this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

U2 Web Services Developer 3.20.4
These release notes provide information about fixes in the U2 Web Services Developer.

Build: 1099
Release Date: March 2013

Fixes in Web Services Developer 3.20.4

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:



U2 Web Services Developer

52

Issue Number Description

UDBT-1260 When a WSD web service was deployed on a computer running UNIX, and
the /.unitools file was empty, it returned a java.io.FileNotFoundException error but
still continued with the deployment. This issue has been resolved.

UDBT-1231 When a user attempted to set up a parameter on a query, and used a question
mark (?) in the statement, the test would fail. This issue has been resolved.

UDBT-605 Prior to this release, WSD did not provide the functionality needed to register a
SOAP server as a service, preventing the server from being started automatically.
Beginning at this release, you can start and stop the SOAP server as a service. To
start the SOAP server as a service:

U2soapservice.exe –i u2soap-server-name [-s u2soap-service-name] [-d
u2soap-service-description]

The default value for -s is u2soap-server. The default value for –d is “U2 soap
service to start and stop U2 soap server”. After you install the service you can start
or stop the u2soap-server as a Windows service from the Windows control panel.
When you start the service it executes ‘runsoapserver.bat u2soap-server’ and waits
until this bat file exits. When you stop the service, it executes ‘stopsoapserver.bat
u2soap-server’. You can pass additional arguments to runsoapserver.bat by
specifying the start parameters to the service.

To remove the SOAP server as a service:

U2soapservice.exe –r u2soap-server

Detailed instructions on deploying a U2 SOAP server as a service can be found in
Web Services Developer’s Guide.

U2 Web Services Developer 3.20.3
These release notes provide information about fixes in the U2 Web Services Developer.

Build: 1080
Release Date: November 2012

Fixes in Web Services Developer 3.20.3

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-602 Beginning at version 1.2.2, the RunSoapServer.bat script referenced an incorrect
list of JAR files and so did not work in the U2 Web Services Developer. This issue
has been resolved.

Note: This fix can only be applied when installing through the InstallShield
package for NOV2012 DBTools.

U2 Web Services Developer 3.20.2
These release notes provide information about fixes in the U2 Web Services Developer.
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Build: 1063
Release Date: August 2012

Fixes in Web Services Developer 3.20.2

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-1064 Users running U2 Web Services Developer 3.20.0 found they could connect from
WSD but when they called the SOAP server from the .NET client, no data or errors
were returned. This issue has been resolved.

U2 Web Services Developer 3.20.2
These release notes provide information about fixes in the U2 Web Services Developer.

Build: 1053
Release Date: June 2012

Fixes in Web Services Developer 3.20.2

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-1006 Users running U2 Web Services Developer 3.20.0 found they could connect from
WSD but when they called the SOAP server from the .NET client, no data or errors
were returned. This issue has been resolved.

U2 Web Services Developer 3.20.1
These release notes provide information about fixes in the U2 Web Services Developer.

Build: 1043
Release Date: March 2012

Fixes in U2 Web Services Developer 3.20.1

There were no specific fixes to this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

Web Services Developer 3.20.0
These release notes provide information about fixes in the U2 Web Services Developer.

Build: 1022
Release Date: January 2012
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Fixes in Web Services Developer 3.20.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following issues were fixed in this release:

Issue Number Description

UDBT-615 Some users found that when they changed the connection details on a SOAP
server, their Web Services definitions and dynamic array definitions were lost. This
occurred if the SOAP server was refactored while a Web Service was not loaded.
This issue has been resolved.

Web Services Developer 1.2.5
These release notes provide information about fixes in the U2 Web Services Developer.

Release Date: October 2010

Fixes in Web Services Developer 1.2.5

There were no customer issues at this release.

Web Services Developer 1.2.4
These release notes provide information about fixes in the U2 Web Services Developer.

Release Date: June, 2010

Fixes in Web Services Developer 1.2.4

The following issues were fixed at this release:

Issue Number Description

12535 Prior to this release, U2 Web Services Developer returned a Java error if the UniRPC
connection timed out and users had enabled SSL on their WSD deployments. This
was a UniObjects for Java problem that was caused by a incorrect socket setting.
 This issue has been resolved.

12935 Before this release, if you specified a unirpc daemon port number other than the
default of 31438 using Web Services Developer, all requests from that daemon still
went to port number 31438. This problem has been resolved.

Web Services Developer 1.2.3
These release notes provide information about fixes in the U2 Web Services Developer.

Release Date: September 2009

Fixes in Web Services Developer 1.2.3

The following issues were fixed at this release:
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Issue Number Description

12062 Prior to this release, web service calls initiated through a Web Services application
would time out if the call duration was longer than 5 minutes. At the current
release of the Web Services Developer, the default timeout of value of 5 minutes is
now user configurable.

To specify the timeout value, click the SOAP Server for which you want to specify
the value with the right mouse button, then click Properties. Click Next, then Next
to the U2 Database - Connection Properties box.

Enter the number of seconds for the UniRPC timeout in the UniRPC Timeout box,
then click Finish.

12093 Before this release, when deploying a SOAP server and selecting the option to use
the SOAP server connection details for all the services was not working properly.
This problem has been fixed.

Web Services Developer 1.2.2
This Readme provides information about fixes in the Web Services Developer.

Release Date: February 2009

Fixes in Web Services Developer 1.2.2

The following issues were fixed at this release:

Issue Number Description

11398 Prior to this release, if you set the value of the SOAP Request Validation property to
true, all web services in that SOAP server failed. The response to any Web service
call was: 

IWAB0135E An unexpected error has occurred. 500 Internal Server Error. 

This problem has been fixed.

Web Services Developer 1.2.1
This Readme provides information about fixes in the Web Services Developer.

Release Date: August 2008

Fixes in Web Services Developer 1.2.1

The following issues were fixed at this release:

Issue Number Description

36803 Beginning at this release, you can start or stop the soap server manually. To start
the soap server, execute "runsoapserver" from the command line. To stop the soap
server, execute "stopsoapserver" from the command line.

Web Services Developer 1.1.2
This Readme provides information about fixes in the Web Services Developer.
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Release Date: October 2007

Fixes in Web Services Developer 1.1.2

The following issues were fixed at this release:

Issue Number Description

9642 Beginning at this release, in the Properties wizard of the Update a SOAP Server
dialog box, the capability to enable or disable Connection Pooling has been added.
This enables the U2 Web Services Developer to communicate with a UniData or
UniVerse server that is running with Connection Pooling disabled.

10189 If a SOAP request was received by Web Services Developer that exceeded 200,000
bytes, Web Services Developer could not read the request. At this release, the http
packet size has been increased to 2 MB, resolving the problem.



57

 U2 Extensible Administration Tool
The release notes in this section provide information about changes in the U2 Extensible
Administration Tool (XAdmin).

XAdmin is an Eclipse-based tool that provides a modern integrated environment for U2 database
administration.

Note:  Most functions in XAdmin require administrative access to the server. If you experience
error messages when connecting to a server or when executing a task, such as File Tools or Data
Encryption, verify that you have the correct permissions or are logged in as an administrative user.
Possible error messages include:

▪ "The subroutine failed to complete successfully"

▪ "Error opening the editor. Reason: Argument cannot be null."

▪ "The RPC failed, possibly the server process exited abnormally.”

In addition, if the expected data is not returned from a task, it could be the result of inadequate
permissions.

U2 Extensible Administration Tool 4.13.0
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

New features and fixes for U2 Extensible Administration Tool 4.13.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:

Issue number Description

UDBT-1186 Prior to this release, XAdmin users were unable to add pattern match exclusions
into the repconfig definition file. This issue has been resolved.

UDBT-1920 Starting at this release, XAdmin no longer allows for duplicate UniRPC service
names, and the Network Type field is now mandatory.

UDBT-2010 Prior to this release, when changing the RPC service name in the Edit U2 Server
Definition window, the old RPC service name would continue to display. This issue
has been resolved.

UDBT-2101 Beginning at this release, the following UniData error logs are available to view in
XAdmin:

▪ smm

▪ cleanupd

▪ sbcs

▪ sm

▪ rm

▪ udt

▪ audit
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Issue number Description

UDBT-2102 Beginning at this release, the following UniVerse error logs are available to view in
XAdmin:

▪ uvsmm

▪ uvcleanupd

▪ uvdlockd

▪ uvrm

▪ errlog
UDBT-2265 Prior to this release, when updating a printer device definition, the OK button was

grayed out after editing fields. This issue has been resolved.
UDBT-2677 Beginning at UniData 8.2.0, U2 Python authorization is available in XAdmin.
UDBT-2819 Starting at this release, users do not need to enter a certificate name and private

key to continue to the next wizard entry screen.
UDBT-2965 Beginning at this release, XAdmin now includes U2 Data Replication field-level

update wizards. Field-level updating was added at UniData 8.2.
UDBT-2996 XAdmin has been enhanced to support audit logging included in UniData 8.2. For

details about audit logging and how it works, see the UniData Security Features
Guide.

UDBT-3023 Windows only. Beginning at UniData 8.1.0, the registry entries for SSL_PROTOCOLS
and SSL_OPTIONS can be edited using XAdmin. To edit these settings, from the
Admin Task List, click Network Services → UDTelnet.

To edit the SSL_PROTOCOLS registry entry, select the following check boxes that
apply:

▪ SSLv3 (This is disabled permanently even though it is visible.)

▪ TLSv1

▪ TLSv1.1

▪ TLSv1.2

If server-side registry entries are present for SSL_PROTOCOLS, the check box
selections default to the current server settings. If no server-side registry entries
are present, TLSv1, TLSv1.1, and TLSv1.2 are selected by default.

To edit the SSL_OPTIONS registry entry, select one of the following options:

▪ NO_TLS_FALLBACK_SCSV

▪ TLS_FALLBACK_SCSV

If server-side registry entries are present, the selected option will default
to the current server setting. If no server-side entries are present,
NO_TLS_FALLBACK_SCSV is selected by default.

UDBT-3058 UniVerse only. Starting at this release, multi-level files are no longer hidden.
UDBT-3136 Prior to this release, the Connect As Admin option for a UniData session in XAdmin

would not be aware of the version of the database it was connecting to. This issue
has been resolved.

UDBT-3142 Starting at DBTools 4.3.0, the Disable NFA Security option has been removed from
XAdmin.
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Issue number Description

UDBT-3148 Windows only. Beginning at UniVerse 11.3, the registry entries for SSL_PROTOCOLS
and SSL_OPTIONS can be edited using XAdmin. To edit these settings, from the
Admin Task List, click Network Services → Telnet.

To edit the SSL_PROTOCOLS registry entry, select the following check boxes that
apply:

▪ SSLv3 (This is disabled permanently even though it is visible.)

▪ TLSv1

▪ TLSv1.1

▪ TLSv1.2

If server-side registry entries are present for SSL_PROTOCOLS, the check box
selections default to the current server settings. If no server-side registry entries
are present, TLSv1, TLSv1.1, and TLSv1.2 are selected by default.

To edit the SSL_OPTIONS registry entry, select one of the following options:

▪ NO_TLS_FALLBACK_SCSV

▪ TLS_FALLBACK_SCSV

If server-side registry entries are present, the selected option will default
to the current server setting. If no server-side entries are present,
NO_TLS_FALLBACK_SCSV is selected by default.

UDBT-3156 Beginning at this release, XAdmin works with the FIPS module if enabled for
UniData 8.2.0 and UniVerse 11.3.1.

UDBT-3161 Beginning at this release, when U2 Audit Logging is enabled, selecting the Audit
tab displays the following message:

U2 Audit Logging is enabled. All Data Encryption
transactions are logged in the U2 Audit Logs.

U2 Extensible Administration Tool 4.12.0
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

New features and fixes for U2 Extensible Administration Tool 4.12.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:

Issue number Description

UDBT-2259 Beginning at 11.2, when a parameter was changed in the XAdmin Configuration
Editor, XAdmin would not respond when the Save button was selected, though the
uvconfig file change was saved. This issue has been resolved.

UDBT-2894 Beginning at this release, Credential Wallet administration tasks have been added
for UniVerse. Users are able to add, update, or delete credential mapping records.
Users are also able to configure and manage wallet tasks such as changing a
password and adding or removing machine tags.
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Issue number Description

UDBT-2991 Windows only. Prior to this release, the setting was not saved when the Allow
Space in User Name check box was selected in the UniData Telnet Server
Configuration dialog box. This issue has been resolved.

U2 Extensible Administration Tool 4.11.0
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

New features and fixes for U2 Extensible Administration Tool 4.11.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:

Issue number Description

UDBT-1186 Prior to this release, XAdmin users were unable to add pattern match exclusions
into the repconfig definition file. This issue has been resolved.

UDBT-1996 Windows only. Prior to this release, uvrestore used single quotes when using
the –F option, which caused restore to fail. This issue has been resolved.

UDBT-2047 Previously, XAdmin users were unable to configure Transaction Logging to
UniVerse. Users would not see a dialog box if the logging directory existed. This
issue has been resolved.

UDBT-2048 Previously, XAdmin users were unable to see the transaction logs for UniVerse after
configuring the Transaction Logging directory. This issue has been resolved.

UDBT-2049 Prior to this release, Transaction Logging systems skipped the active/current log
file for XAdmin users. This issue has been resolved.

UDBT-2055 Previously, XAdmin users could not restore individual files due to an incorrect
uvrestore syntax. This issue has been resolved.

UDBT-2068 From this release, all DBTools connections to the database can be SSL enabled
through the U2 Resource View.

UDBT-2212 Previously, the descriptions of configuration parameters RFS_DUMP_HISTORY and
RFS_DUMP_DIR were missing from the XAdmin Configuration Editor. Descriptions
have been added for these parameters. This issue has been resolved.

UDBT-2273 Prior to this release, XAdmin users were unable to delete UniData accounts. This
issue has been resolved.

UDBT-2638 Previously, XAdmin users saw an incorrect error message when they attempted
to use Audit Configuration with a non-root user ID. Users will now see a more
meaningful error message. This issue has been resolved.

UDBT-2756 Prior to this release, XAdmin users may have seen the Start Telnet service button
grayed out. If this occurred, it was likely because the telnet ports were disabled. To
enable telnet ports, deselect the Disable Telnet Port and/or Disable SSL Telnet
Port and save it. The Start button will now become available.

UDBT-2797 Previously, the Disable Telnet Port and Disable SSL Telnet Port were selected in
the telnet tab for XAdmin users by default. The check boxes are now deselected by
default. This issue has been resolved.

UDBT-2799 Beginning at this release, a new task field has been added to administer Credential
Wallets. This task is called the Credential Manager.
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U2 Extensible Administration Tool 3.12.1
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

New Features and Fixes in U2 Extensible Administration Tool 3.12.1

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:

Issue Number Description

UDBT-1428 An enhancement has been made to include replication enablement and
disablement.

UDBT-2501 Prior to this release, the Audit tab was inadvertently removed from XAdmin. This
issue has been resolved, and the Audit tab is available.

UDBT-2263 Prior to this release, when using XAdmin or UniAdmin to load programs into
catalog shared memory, the SHM.TO.LOAD file was created in UVHOME. When
UniVerse was restarted, the file was read. This would cause the UniVerse Resource
Service to crash in 64-bit UniVerse 11.2.3. This issue has been resolved.

UDBT-2498 Prior to this release, when the Data Encryption > Audit > Choose Operations
option was selected in XAdmin, the list of operations was inaccurate and did not
reflect updated operations. This issue has been resolved.

UDBT-2451 Prior to this release, if XAdmin was used to resize a file and then selected the
dictionary, the DICT parameter was misplaced, causing a syntax error. This issue
has been resolved.
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Issue Number Description

UDBT-2275 An enhancement has been made to include the following new configuration
parameters in the XAdmin Configuration Editor:

TOGGLE_NAP_TIME_NS - Controls the wait time on retrying to gain a shared
memory address in UNIX. Do not change this value unless Rocket advises you to do
so.

SINGLE_SAVEDLIST - Controls if the SAVE.LIST verb produces a single or
multiple records in the SAVEDLISTS directory.

WHOLEFILE_SPLIT_LOAD - The default split load value for a WHOLEFILE
dynamic file if no value is specified on creation.

WHOLEFILE_MERGE_LOAD - The default merge load value for a WHOLEFILE
dynamic file if no value is specified on creation.

DEFAULT_SPLIT_STYLE - The default split style for a dynamic file if no style is
specified on creation.

HTTP_DEFAULT_VERSION - The default HTTP version used in the UniBasic if not
programmatically set.

SSL_PROTOCOLS - UniData and UniVerse (U2) support multiple secure
transmission protocols; including SSLv3, TLSv1, TLSv1.1 and TLSv1.2. The newer
protocols (TLSv1.2 is the latest) are more robust and secure. SSLv3 has been found
to have many security vulnerabilities at the protocol or implementation level,
the most serious of which are Heartbleed and POODLE. TLSv1 also has security
problems.

We recommend using the strongest protocol supported by both the client
and server. If your client and server are both the latest Rocket U2 products,
then TLSv1.2 will likely be used by default. However, many users still need to
communicate with older U2 or third party servers which may not support the latest
protocols.

SSL_PROTOCOLS allows you to control which protocols are permitted to be
used. Use a comma (,) or plus sign (+) separated protocol list. The default is:
SSL_PROTOCOLS=TLSv1,TLSv1.1,TLSv1.2 Note: By default, SSLv3 is turned off.
This is to follow the industry recommendations following POODLE. If you must use
SSLv3 it needs to be added back manually. Before an SSL connection is attempted,
this configuration value will be used in conjunction with the version setting in the
Security Context Record (SCR) or Security Property List (SPL) to determine the
protocols to use during SSL handshake.

SSL_OPTIONS - Downgrade protection is a feature of a cryptographic protocol so
that the client and server sides use the strongest protocol version available. Even
in the absence of malicious attacks such as POODLE, downgrades are not advised.
For example, even if SSLv3 is turned off, if both sides support TLSv1.2, you do not
want to downgrade to TLSv1.1 or TLSv1. The TLS_FALLBACK_SCSV flag, which is
supported by UniData 8.1 and UniVerse 11.3, resolves the voluntary downgrade
problem introduced by SSL clients.

For the TLS_FALLBACK_SCSV to take effect, it must be supported by both
the client and server. Some older servers reject connections if they receive
TLS_FALLBACK_SCSV from a client, even if it supports the protocols advertised
by the client. For this reason, UniData and UniVerse ship with the default
SSL_OPTIONS setting as: SSL_OPTIONS=NO_TLS_FALLBACK_SCSV If you
want to prevent protocol downgrade and both your client and server support
TLS_FALLBACK_SCSV, change the value to TLS_FALLBACK_SCSV.
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U2 Extensible Administration Tool 3.12.0
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

New Features and Fixes in U2 Extensible Administration Tool 3.12.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:

Issue Number Description

UDBT-659 Prior to this release, the XAdmin tool did not work correctly in an NLS
environment. XAdmin now works as expected. This issue has been resolved.

UDBT- 1886 The File Tools context menu in the U2 Resource view of XAdmin presented a list of
UniData tools even for users in a UniVerse account. This issue is resolved.

UDBT- 1901 You can view and refresh the current audit log file status in XAdmin with a new
window that has been added to the Audit Configuration administration task.

UDBT-1912 The following parameters have been added to XAdmin and are available for
UniData 7.4 or later:

When you create a new U2 file you can define it as a 64-bit file by selecting the 64-
bit checkbox. If you do not select the 64-bit option, the file will be created as a 32-
bit file by default.

The File Tools > Guide option now features the Saving File Load (-sfl) parameter.

The File Tools > Memresize option now features the ability to specify either 32-bit
or 64-bit files.

UDBT-1923 Using a new check box added to the telnet settings tab in XAdmin, you now can
choose to disable telnet and SSL telnet. If you check Disable Telnet Port, the port is
set to 0 and the server does not listen on that port. If you check Disable SSL Telnet
Port, the SSL telnet port is set to 0 and the server does not listen on that port.

UDBT-1941  If you opened XAdmin without first starting the UniData server and then tried to
connect to the server, the connection failed as expected. If you then right-clicked
the server, Disconnect appeared in the context menu. The option to disconnect
should not have been presented, because there was no active connection. This
issue has been resolved.

UDBT-1945 XAdmin support for encrypted SSL configuration files has been added at this
release and will be fully available for connections to UniData 7.4 or later and
UniVerse 11.2.5 or later when released.

UDBT-2018 XAdmin now supports account-based licensing for UniVerse 11.2.0.
UDBT-2023 Beginning at this release, XAdmin supports SHA-2 self-signed certificates.
UDBT-2133 In the January 2014 version of XAdmin, the telnet window closed when you clicked

OK. The window should have closed only if you clicked Close or X. This issue is
resolved.

UDBT-2162 Beginning at this release, users can specify PKCS #12 security certificates
UDBT-2172 Beginning at this release, 74 is an available option for UniData users in the

replication system definition.
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U2 Extensible Administration Tool 3.11.2
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

Build: 2082
Release Date: January 2014

New Features and Fixes in U2 Extensible Administration Tool 3.11.2

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:

Issue Number Description

UDBT-138 Prior to this release, when a user selected the Replication > Monitor Replications
> Replications option, the replication status did not automatically refresh and
users had to manually exit and restart the monitor to see the status change. This
issue has been resolved.

UDBT-1597 Prior to this release, XAdmin users were unable to change only the expiration date
when making a license change. Beginning at this release, clicking the Save button
after making a change to the expiration information will save the changes. This
issue has been resolved.

UDBT-1770 Prior to this release, when a change was made to the audit configuration file, the
change was not seen in the audit config view. Users had to restart the audit config
view to sync the two views. Now, when a change is saved in the configuration
file, it is also reflected in the audit config view automatically. This issue has been
resolved.

U2 Extensible Administration Tool 3.11.1
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

Build: 2054
Release Date: November 2013

New Features and Fixes in U2 Extensible Administration Tool 3.11.1

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:

Issue Number Description

UDBT-1660 Prior to this release, the Checkover, Filever, Udfile and Shfbuild options were
available in UniAdmin but not in XAdmin. These options are now available in
XAdmin and can be accessed from the Admin Tasks > File tools menu. This issue
has been resolved.
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U2 Extensible Administration Tool 3.11.0
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

Build: 2025
Release Date: October 2013

New Features and Fixes in U2 Extensible Administration Tool 3.11.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:

Issue Number Description

UDBT-1644 A U2 Replication task group has been added to the XAdmin menu options.
This group contains options to update or view information about replication
configuration, logs, performance, and status.

UDBT-1643 The "Replication logs" task has been added to the U2 Replication group in XAdmin.
This new task allows users to view the uvrm.log and uvrm.errlog files from within
the U2 Replication task group.

UDBT-1601 Users who installed XAdmin 3.10.9 found that the XAdmin Telnet service displayed
incorrect Telnet service port numbers. This issue has been resolved.

UDBT-1587 UniData users who upgraded to XAdmin v 3.10.9 found that the Replication
Monitor tab was not there anymore. The replication monitor can now be
found under the U2 Replication tree view, with the option name changed from
Replication Monitor to Status. This issue has been resolved.

UDBT-1370 XAdmin now supports account-based licensing for UniVerse 11.2.0.
UDBT-1359 Replication performance monitoring has been added to XAdmin. Users can now

access the performance monitor by navigating to the U2 Replication task.
UDBT-1266 XAdmin has been enhanced to support the new audit logging features included

in UniVerse 11.2.0. For details about audit logging and how it works, refer to the
UniVerse Security manual.

U2 Extensible Administration Tool 3.10.9
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

Build: 1114
Release Date: June 2013

New Features and Fixes in U2 Extensible Administration Tool 3.10.9

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:
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Issue Number Description

UDBT-1420 After upgrading UniData (for example, from 7.3.3 to 7.3.4), users who updated
the license information and entered an 8-digit serial number found that when a
connection was then made to Unidata, the XAdmin License screen displayed only
the first 7 digits of the serial number. This issue has been resolved.

UDBT-1460 Some users found that if they used the ‘Connect as Admin’ option, they would
see incorrect repsys and repconfig screens that included replication options.
After making changes to these screens and clicking Finish would then write back
incorrect values, corrupting the configuration files. The Replication option is now
disabled when using the ‘Connect as Admin’ option because this feature requires a
fully licensed connection.

U2 Extensible Administration Tool 3.10.8
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

Build: 1108
Release Date: May 2013

New Features and Fixes in U2 Extensible Administration Tool 3.10.8

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:

Issue Number Description

UDBT-936 The XAdmin tool could not create a correct x509 certificate request file. Only the
state name was being used to create the certificate name. This issue has been
resolved and now the certificate is created using the Common Name for the
certificate.

UDBT-1183 The XAdmin tool was not correctly refreshing the Replication Group list and was
adding a duplicated entry whenever a new Group was added. This issue has been
resolved.

U2 Extensible Administration Tool 3.10.6
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

Build: 1099
Release Date: March 2013

New Features and Fixes in U2 Extensible Administration Tool 3.10.6

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:
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Issue Number Description

UDBT-1252 Prior to this release, replication recovery logs could not be displayed in XAdmin.
This issue has been resolved.

U2 Extensible Administration Tool 3.10.5
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

Build: 1080
Release Date: November 2012

New Features and Fixes in U2 Extensible Administration Tool 3.10.5

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:

Issue Number Description

UDBT-1168 In the configuration editor in XAdmin, there are two columns after each parameter:
the current value and the new value. Prior to this release, when the user entered a
new value and saved the change, the new value column was not cleared. This issue
has been resolved.

UDBT-987 Prior to this release, any warning message resulting from a change made in
the Configuration Editor was treated as an error and disallowed changes to the
configuration.  This fix correctly displays warnings but does not prohibit saving of
the configuration.

UDBT-313 Prior to this release, UniData users could not use XAdmin without consuming a
license. In instances when all licenses were consumed an administrator could not
use XAdmin to perform any administration tasks, such as clearing the licenses. To
solve this problem, the following changes have been made to XAdmin:

▪ A Connect as Admin option has been added to the U2 Resource view. When
you select this field, you can sign into XAdmin as an administrator to perform
tasks that do not require a UniData license.

▪ A Number of Admin Connections field has been added to the server properties
view, which allows you to monitor the number of Admin connections in use.

This issue has been resolved.

U2 Extensible Administration Tool 3.10.4
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

Build: 1069
Release Date: September 2012

New Features and Fixes in U2 Extensible Administration Tool 3.10.4

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.
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The following new features and fixes are implemented at this release:

Issue Number Description

UDBT-929 Prior to this release, XAdmin users could not re-enable the print queuing option.
This issue applied to UniVerse only and has been resolved.

UDBT-1076 At this release, a User ID button has been added to the XAdmin Locks menu. Users
can use this option to clear all locks for a specific user ID.

U2 Extensible Administration Tool 3.10.3
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

Build: 1063
Release Date: August 2012

New Features and Fixes in U2 Extensible Administration Tool 3.10.3

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:

Issue Number Description

UDBT-989 After updating the UniData license through XAdmin, users saw an incorrect
message directing them to IBM Support to obtain an authorization code.  This
message has been corrected to notify the customer to contact Rocket Software.

UDBT-1046 Prior to this release, XAdmin users could not clear locks when connected to
UniData servers.  Locks can now be cleared by selecting the Clear Locks button
under the Locks task.

U2 Extensible Administration Tool 3.10.2
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

Build: 1045
Release Date: April 2012

New Features and Fixes in U2 Extensible Administration Tool 3.10.2

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:

Issue Number Description

UDBT-139 When connecting XAdmin to a server as a non-root user, users saw error messages
that did not describe permissions problems accurately.  Error messages have been
corrected in this update that more accurately describe the permission problems to
the user.
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Issue Number Description

UDBT-141 Print spooler options available for UniVerse on UNIX within UniAdmin were not in
previous versions of XAdmin.  This update adds the print spooler functionality to
XAdmin when connected to UniVerse servers on UNIX.

UDBT-682 When selecting the “File Tools” task in XAdmin connected to a UNIX server, users
saw the following error message: “The subroutine failed to complete successfully.”
  This condition was determined to be caused by lack of permissions.  A more
appropriate error message indicating the permission error has been added at this
update.

UDBT-935 When using the “Import” functions of the Replication task in XAdmin with
UniData 7.3, an error was returned saying 'Failed to start remote admin
program;errcode=81014.’ This was caused by XAdmin not passing the version
number to the server, making the system unreachable. This issue has been
resolved in this update.

UDBT-939 When connected to a UniData 7.3 server, XAdmin produced an incorrect entry in
the repconfig file containing a trailing ‘:’ that resulted in UniData not starting. This
problem has been resolved in this update.

U2 Extensible Administration Tool 3.10.1
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

Build: 1043
Release Date: March 2012

New Features and Fixes in U2 Extensible Administration Tool 3.10.1

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:

Issue Number Description

UDBT-127 The User Counter metric and the option to modify the vertical scale of the counter
has been implemented in the Performance Monitors graph and report views.

UDBT-130 The File Tools task has been implemented in the Admin Tasks view of the UniData
edition. This option enables you to run UniData file tools Convcode, Convdata,
Convidx, Convmark, Dumpgroup, Fixfile, Fixgroup, Guide, and Memresize in the
XAdmin interface.

UDBT-136 The RFS Monitor is now implemented in the UniData edition of XAdmin, allowing
you to view the performance of the UniData Recoverable File System (RFS) in real
time.

UDBT-146 An RFS Configuration task has been implemented in the Admin Tasks view of the
UniData edition. With this feature, you can configure archiving and logging for the
UniData Recoverable File System (RFS).

UDBT-148 The GLM and UPL tools are now available in the Tools option of the Admin Tasks
view in the UniData edition of XAdmin. The GLM Tool and UPL Tool can be used to
display a map of locks, holding locks, and waiting queues for a transaction.
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Issue Number Description

UDBT-263  A first iteration of U2 Extensible Administration Tool Help is available in V3.10.1.
You can access it from the XAdmin main menu by selecting Help > Help Contents.
The Help content is limited in this initial release; it covers several tasks from the
Admin Tasks menu, giving you a preview of other tasks to come. We plan to add
content iteratively in this Help system in future releases of U2 DBTools.

UDBT-300 When using the SSL Configuration tool to generate an x.509 certificate signing
request (CSR) , a .req file was created incorrectly in DER format. The product
requires the CSR to be in PEM format. If the user selected DER as the key format,
the SSL Configuration tool incorrectly created the CSR in DER format as well.
The .req file is now created in PEM format, regardless of the key format.

UDBT-314 Version 3.10.1 implements the ability to save graphs and reports. With this
enhancement, you can customize a graph or report and save the values for future
use.

UDBT-622 The ability to modify the event logging level is now supported in the UniData
edition of XAdmin.

Extensible Administration Tool 3.10.0
These release notes provide information about new features and fixes in the Extensible Administration
Tool (XAdmin).

Build: 1022
Release Date: January 2012

New Features and Fixes in Extensible Administration Tool 3.10.0

To see a list of fixes and new features common to all U2 Eclipse-based tools, see Shared components,
on page 4.

The following new features and fixes are implemented at this release:

Issue Number Description

UDBT-132 When using XAdmin to add a tape device on a UNIX platform, both the No Rewind
and Rewind paths were automatically populated with “/dev”, and the Lock File
was populated with “/”. If the user did not change the default values, XAdmin
returned an error message, “Rewind path and no-rewind path must be different.”
In addition, the dialog box contained a “Dos Commands” area that was irrelevant
to UNIX. In version 3.10.0, the default values for the Rewind path and Lock File
have been modified, and the Dos Commands area has been removed from the
dialog box.

UDBT-135 In the Add Printer Device dialog box, the label for adding a form contained a
typographical error, “From”. The label has been changed to “Form”.

UDBT-137,
UDBT-152

If the user changed any value in the Telnet configuration and clicked OK to save
changes, the new values were not saved. XAdmin returned an error, “RPC Call Error
- The Subroutine failed to complete successfully,” and the UniVerse section of
the Registry was missing the appropriate Telnet keys. With a fix in version 3.10.0,
Telnet values are saved correctly. In addition, the button label has been changed
from “OK” to “Save” to clarify its purpose.

UDBT-143 With an error log active and UOLOGIN in use, XAdmin wrote UOLOGIN errors
to the main UniData or UniVerse error log, rather than the UniObjects error log
as expected. A global variable now manages UOLOGIN error logging correctly,
resolving this issue for both UniData and UniVerse.
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Issue Number Description

UDBT-150 For UniVerse only, the Backup option always saved the first account in the list,
regardless of whether the user had selected a different account. This issue has
been fixed and the Backup option now saves the selected account as designed.

UDBT-153 When connected to a UniVerse server on UNIX, if the user selected the Users
option, the dialog box contained a User# field displaying information that was not
relevant to UNIX. The Users dialog box now displays the User# column only when
connected to a Windows server. This column has been removed from the display
when connected to a UNIX server.

UDBT-156 In the Add Telnet User dialog box, if the user clicked the Add button in the Local
Machines area, the Add Local Machine Information dialog box was displayed,
but it prompted for Domain Account information rather than Local Machine and
Account. The field labels in the Add Local Machine Information dialog box have
been changed to prompt for the correct information.

UDBT-164 When connected to a UniData server, XAdmin licensing did not validate the
number entered in the Device License box. The validation routine should have
enforced a restriction on the number of device licenses as 0 or an integer from 2
to 10. The program now validates the number of device licenses to enforce these
restrictions as designed.

UDBT-165 In the Network Services > Database Admin option, if the user clicked the Update
button and then browsed for a path in either the UDTHOME or UniData Account
field, XAdmin displayed the error message, “The RPC failed, possibly the server
process exited abnormally.” The user was then unable to browse to any path. The
fix to a related issue has resolved this problem in version 3.10.0.

UDBT-166 In UniVerse only, if the user selected a file in the File Tool dialog box, the four
extra options (Properties, Statistics, Diagnostics, and Repair) were unavailable
(dimmed). This issue has been corrected, and the extra options can now be
selected as designed.

UDBT-169 After adding an NFA server, the NFA service must be restarted to complete the
process of creating the NFA server. In previous versions, the NFA service did not
restart automatically or prompt the user to restart it manually. This issue has been
addressed in version 3.10.0, and the user is prompted to restart the NFA service
after adding an NFA server.

UDBT-288 In UniVerse only, validation of administrator logon credentials was not performed
correctly and did not prevent non-administrator users from performing certain
tasks. In version 3.10.0, the security routine for UniVerse servers has been
amended to correctly validate credentials.

UDBT-299 Several field labels in the File Tools option Statistics dialog box contained
typographical errors. These errors have been corrected in version 3.10.0.

UDBT-304 When monitoring U2 Replication, XAdmin displayed a remote procedure call (RPC)
error in a loop when a UniVerse system was shut down: “The RPC failed, possibly
the server process exited abnormally.” Changes to error handling and Replication
processing prevent this looping error in version 3.10.0.

UDBT-306 XAdmin 3.10.0 implements the UniVerse logon cache as a new feature. The user
can turn the persistence logon cache on or off by selecting or clearing a check box.
The user can also delete a cache entry from the logon cache.
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Issue Number Description

UDBT-586 If the user right-clicked a U2 server in the U2 Resource view, the Performance
Monitor graph and report views were started by default. Each monitor view
consumes a license, so as an undesired effect, the monitors used extra licenses
by default. If the user closed a monitor view, the license was not released, and
the server connection sometimes became unresponsive. In version 3.10.0, the
Performance Monitor views are no longer started by default. A license is consumed
for each monitor, but only if the user chooses to start it.

UDBT-617 In the Replication option, the screen “wobbled” when expanding columns and
caused XAdmin to hang while monitoring either the publisher or the subscriber. A
fix resolves this issue in version 3.10.0, and columns remain stable after they have
been expanded.

UDBT-627 Horizontal and vertical scroll bars were missing from editor views that were sized
too small to display all buttons and other content. The code has been amended to
add scroll bars as necessary in version 3.10.0.

Extensible Administration Tool 2.1.4
This Readme provides information about fixes in the Extensible Administration Tool (XAdmin).

Build: 7444
Release Date: May 2011

Fixes in Extensible Administration Tool 2.1.4

The following issues were fixed at this release:

Issue Number Description

UCC-982 A memory leak occurred in the XAdmin Performance Monitor graph view when the
refresh interval was set to 1 second.  This issue has been fixed.

UCC-974 In the XAdmin uv_repadmin tool, when a user utilized the Target option to add a
selected target to the target table and chose a group as the selected target, the
user would be prompted to choose from a selected distribution as well.  Supplying
both a system ID and a group ID would then cause the uv_repadmin tool to fail. 
This issue has been resolved. 

Note: At this release, you cannot sync with targeted replications.
UCC-1006 A stand-alone XAdmin tool is now available.
UCC-1107 In the Xadmin uv_repadmin tool, users who attempted to select targets and chose

the local system saw the following error message: No such replication. This issue
has been resolved and the local system is no longer an option.

UCC-1116 The File Tools option has been added to the Admin Tasks menu in XAdmin.  Users
can use the available File Tools options to view properties and statistics, run file
diagnostics, and run file repair programs.

Extensible Administration Tool 2.1.3
This Readme provides information about fixes in the Extensible Administration Tool (XAdmin).

Build: 7433
Release Date: March 2011
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Fixes in Extensible Administration Tool 2.1.3

The following issues were fixed at this release:

Issue Number Description

UCC-729 The Licensing option in the U2 Extensible Administration Tool now supports
licensing reports and cleanup for UniVerse.

UCC-744 You can now send messages to other users through the Users view in the U2
Extensible Administration Tool.

UCC-786 At this release, unirpc support for Network Services when connecting to a UNIX
server has been added.

UCC-833 A problem was discovered when using the recording and playback feature of the
Performance Monitor. When trying to play back data, the following error was
displayed:   

"Unable to open file PERFMON.DATA in account UV, STATUS() is -1"

 

The U2 Extensible Administration Tool now searches for the PERFMON.DATA file in
the account you specify, correcting the problem.

UCC-927 Resizing the UniVerse Dead Lock window in the U2 Extensible Administration Tool
caused the tool to throw a Java error and exit. This problem has been corrected.

UCC-941 When trying to restore the default password policies for ALL encryption keys in
Automatic Data Encryption, an error occurred indicating that ALL was not a valid
package. This error message remained on the screen. Now, the ALL option restores
the default policies for encryption keys, wallets, and the master key, and the
message is cleared once another operation has been performed.

UCC-946 Beginning at this release, you can select the level of event logging through the U2
Extensible Administration Tool. You can select whether to report error messages,
warning messages, or informational messages for UniVerse, Telnet, UVSMM, UCI,
UVNet, UVCleanupd, UVDlockD, UniRPC, and UniVerse Replication. To set the levels
of event logging, click Logging, then click Event Logging Level.

UCC-948 The U2 Extensible Administration Tool now displays the error logs for the uvsmm,
uvcleanupd, uvdlockd, and the uvrm processes if they are supported on the server
to which you are connected.

UCC-964 In the Generate SSL Certificate Wizard, selecting and clearing check boxes in the
X.509 v3 Certificate Extensions dialog box did not work properly. This behavior
has been corrected in version 2.1.3. In addition, field labels in this wizard used a
mixture of terms for the same type of certificate; the term “CA Certificate” has been
standardized to “Signing Certificate.”

UCC-982 A memory leak discovered when running the U2 Extensible Administration Tool
Performance Monitor has been fixed.

UCC-977 In UniVerse BASIC the XTOOLSUB subroutine now contains the SetRCPToolName
(67) parameter, which reports which Eclipse tool called the subroutine. Valid
values are xmlbd, eda, wsd, xadmin, and bdt.

UCC-983 The U2 Extensible Administration Tool would hang when attempting to encrypt a
file using WHOLERECORD mode without providing an encryption key password on
UniVerse. This problem occurred because incorrect encryption parameters were
sent to the server, and has been fixed.

UCC-992 he Event Logging Level view was displaying incorrect server information before
this release. This problem has been fixed.

UCC-985,
UCC-997

Before this release, the UniData license expiration date did not display properly in
the U2 Extensible Administration Tool. This problem has been fixed.
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Issue Number Description

UCC-1016 You can now update the DISTRIBUTION phrase of U2 Data Replication through the
U2 Extensible Administration Tool.

UCC-1021 Beginning at this release, you can now successfully set up U2 Data Replication
from the U2 Extensible Administration Tool.

UCC-1023 The Telnet Users functionality is now available in the U2 Extensible Administration
Tool.

UCC-1042   When you logged into the database as a non-administrator user, and you did
not have permission to the VOC and the VOCLIB files, the following message was
displayed:   

"The subroutine failed to complete successfully"

After this message, no administration tasks could be performed successfully from
the U2 Extensible Administration Tool.

This problem has been fixed.
UCC-1052 In the UniVerse Command view, the following message is displayed when

attempting to execute a stack function, such as .L, .D, .X, and so forth:   

"." command not supported
UCC-1059 In the Accounts view of the U2 Extensible Administration Tool, the path to the

account was displayed with the user and group of the creator of the account
appended. The user and group have been removed from the path at this release.

UCC-1061 Prior to this release, the U2 Extensible Administration Tool did not show if
the UniData or UniVerse was authorized, and the authorization code was not
validated. These problems have been fixed.

UCC-1066 The U2 Extensible Administration Tool is now available as a standalone product
and as part of the U2 Client release.

UCC-1074 Non-root administrator users now have access to administrative functions.
UCC-1073 Extensibility functions were added at this release of the U2 Extensible

Administration Tool.
UCC-1087 You can now load cataloged UniBasic and UniVerse BASIC programs into shared

memory through the U2 Extensible Administration tool and run them from there.
Shared memory reduces the amount of memory needed for multiple users to run
the same program at the same time.
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U2 XML/DB Tool
The release notes in this section provide information about changes in the U2 XML/DB Tool.

The U2 XML/DB Tool is a graphical user interface tool with which you can create an XML mapping file
to use when exporting or importing XML documents with the UniData or UniVerse databases.

U2 XML/DB Tool 4.43.0
This release note provides information about fixes in the U2 XML/DB Tool.

Fixes in U2 XML/DB Tool 4.43.0

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 XML/DB Tool 4.42.0
This release note provides information about fixes in the U2 XML/DB Tool.

Fixes in U2 XML/DB Tool 4.42.0

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 XML/DB Tools 4.41.0
This release note provides information about fixes in the U2 XML/DB Tool.

Fixes in U2 XML/DB Tools 4.41.0

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all Eclipse-based tools, see Shared components, on page 4.

U2 XML/DB Tool 3.42.1
This release note provides information about fixes in the U2 XML/DB Tool.

Fixes in U2 XML/DB Tool 3.42.1

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 XML/DB Tool 3.42.0
This release note provides information about fixes in the U2 XML/DB Tool.
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Fixes in U2 XML/DB Tool 3.42.0

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 XML/DB Tool 3.41.2
This release note provides information about fixes in the U2 XML/DB Tool.

Build: 2082
Release Date: January 2014

Fixes in U2 XML/DB Tool 3.41.2

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 XML/DB Tool 3.41.1
This release note provides information about fixes in the U2 XML/DB Tool.

Build: 2054
Release Date: November 2013

Fixes in U2 XML/DB Tool 3.41.1

The version number for all DBTools was increased at this release. To see a list of fixes and new features
common to all U2 Eclipse-based tools, see Shared components, on page 4.

U2 XML/DB Tool 3.41.0
This release note provides information about fixes in the U2 XML/DB Tool.

Build: 2025
Release Date: October 2013

Fixes in U2 XML/DB Tool 3.41.0

There were no fixes specific to this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

U2 XML/DB Tool 3.40.1
This release note provides information about fixes in the U2 XML/DB Tool.

Build: 1043
Release Date: March 2012
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Fixes in U2 XML/DB Tool 3.40.1

There were no fixes specific to this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

XML/DB Tool 3.40.0
This release note provides information about fixes in the XML/DB Tool.

Build: 1022
Release Date: January 2012

Fixes in XML/DB Tool 3.40.0

There were no fixes specific to this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

XML/DB Tool 1.3.5
This Readme provides information about fixes in the XML/DB Tool.

Build: 7409
Release Date: October 2010

Fixes in XML/DB Tool 1.3.5

There were no customer issues at this release.

XML/DB Tool 1.3.4
This Readme provides information about fixes in the XML/DB Tool.

Release Date: June 2010

Fixes in XML/DB Tool 1.3.4

There were no customer issues at this release.

XML/DB Tool 1.3.3
This Readme provides information about fixes in the XML/DB Tool.

Release Date: February 2009

Fixes in XML/DB Tool 1.3.3

There were no customer issues at this release.
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XML/DB Tool 1.3.2
This Readme provides information about fixes in the XML/DB Tool.

Release Date: August 2008

Fixes in XML/DB Tool 1.3.2

The following issues were fixed at this release:

Issue Number Description

10829 Prior to this release, if you removed the UniData demo account and updated the
entry in the ud_database file to point to a different account, the XML/DB tool could
not connect to that account. This problem has been fixed.

37004 Before this release, the value of Default was automatically set to Append for the
"Exist-Record-Action" option when creating or editing an XMAP file through the
XML/DB tool if the Default button was selected. This problem has been fixed.

XML/DB Tool 1.3.1
This Readme provides information about fixes in the XML/DB Tool.

Release Date: October 2007

Fixes in XML/DB Tool 1.3.1

The following issues were fixed at this release:

Issue Number Description

9677 Before this release, the "Next" button in the Create_XMAP and U2 Files in the XML/
DB Tool did not function. This problem has been fixed.
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XTOOLSUB
The release notes in this section provide information about changes to XTOOLSUB.

XTOOLSUB 4.103.0
This release note provides information about fixes to XTOOLSUB.

Fixes in XTOOLSUB 4.103.0

There were no fixes specific to this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

XTOOLSUB 4.102.0
This release note provides information about fixes to XTOOLSUB.

Fixes in XTOOLSUB 4.102.0

There were no fixes specific to this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

XTOOLSUB 4.101.0
This release note provides information about fixes to XTOOLSUB.

Build: 2466

Release Date: December 2015

Fixes in XTOOLSUB 4.101.0

There were no fixes specific to this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

XTOOLSUB 3.102.2
This release note provides information about fixes to XTOOLSUB.

Build: 2258
Release Date: January 2015

Fixes in XTOOLSUB 3.102.2

There were no fixes specific to this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.
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XTOOLSUB 3.102.0
This release note provides information about fixes to XTOOLSUB.

Build: 2244
Release Date: August 2014

Fixes in XTOOLSUB 3.102.0

There were no fixes specific to this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

XTOOLSUB 3.101.0
This release note provides information about fixes to XTOOLSUB.

Build: 2025
Release Date: October 2013

Fixes in XTOOLSUB 3.101.0

There were no fixes specific to this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

XTOOLSUB 3.100.4
This release note provides information about fixes to XTOOLSUB.

Build: 1080
Release Date: November 2012

Fixes in XTOOLSUB 3.100.4

There were no fixes specific to this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.

XTOOLSUB 3.100.1
This release note provides information about fixes to XTOOLSUB.

Build: 1043
Release Date: March 2012

Fixes in XTOOLSUB 3.100.1

There were no fixes specific to this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.
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XTOOLSUB 3.100.0
This release note provides information about fixes to XTOOLSUB.

Build: 1022
Release Date: January 2012

Fixes in XTOOLSUB 3.100.0

There were no fixes specific to this release. To see a list of fixes and new features common to all U2
Eclipse-based tools, see Shared components, on page 4.
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Notices
Edition

Publication date: July 2017
Book number: UDBT-430-ALL-RN-01
Product version: Version 4.3.0

Copyright
© Rocket Software, Inc. or its affiliates 2005-2017. All Rights Reserved.

Trademarks

Rocket is a registered trademark of Rocket Software, Inc. For a list of Rocket registered trademarks go
to: www.rocketsoftware.com/about/legal. All other products or services mentioned in this document
may be covered by the trademarks, service marks, or product names of their respective owners.

Examples

This information might contain examples of data and reports. The examples include the names of
individuals, companies, brands, and products. All of these names are fictitious and any similarity to
the names and addresses used by an actual business enterprise is entirely coincidental.

License agreement

This software and the associated documentation are proprietary and confidential to Rocket Software,
Inc. or its affiliates, are furnished under license, and may be used and copied only in accordance with
the terms of such license.

Note:  This product may contain encryption technology. Many countries prohibit or restrict the
use, import, or export of encryption technologies, and current use, import, and export regulations
should be followed when exporting this product.

http://www.rocketsoftware.com/about/legal
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Corporate information
Rocket Software, Inc. develops enterprise infrastructure products in four key areas: storage, networks,
and compliance; database servers and tools; business information and analytics; and application
development, integration, and modernization.

Website: www.rocketsoftware.com

Rocket Global Headquarters
77 4th Avenue, Suite 100
Waltham, MA 02451-1468
USA

To contact Rocket Software by telephone for any reason, including obtaining pre-sales information
and technical support, use one of the following telephone numbers.

Country Toll-free telephone number

United States 1-855-577-4323
Australia 1-800-823-405
Belgium 0800-266-65
Canada 1-855-577-4323
China 400-120-9242
France 08-05-08-05-62
Germany 0800-180-0882
Italy 800-878-295
Japan 0800-170-5464
Netherlands 0-800-022-2961
New Zealand 0800-003210
South Africa 0-800-980-818
United Kingdom 0800-520-0439

Contacting Technical Support

The Rocket Community is the primary method of obtaining support. If you have current support and
maintenance agreements with Rocket Software, you can access the Rocket Community and report
a problem, download an update, or read answers to FAQs. To log in to the Rocket Community or to
request a Rocket Community account, go to www.rocketsoftware.com/support.

In addition to using the Rocket Community to obtain support, you can use one of the telephone
numbers that are listed above or send an email to support@rocketsoftware.com.

http://www.rocketsoftware.com
http://www.rocketsoftware.com/support
mailto:support@rocketsoftware.com

	Rocket U2 DBTools overview
	Shared components
	U2 DBTools Shared Components 4.3.0
	U2 DBTools Shared Components 4.2.0
	U2 DBTools Shared Components December 2015
	U2 DBTools Shared Components January 2015
	U2 DBTools Shared Components August 2014
	U2 DBTools Shared Components January 2014
	U2 DBTools Shared Components November 2013
	U2 DBTools Shared Components October 2013
	U2 DBTools Shared Components June 2013
	U2 DBTools Shared Components May 2013
	U2 DBTools Shared Components March 2013
	U2 DBTools Shared Components November 2012
	U2 DBTools Shared Components May 2012
	U2 DBTools Shared Components March 2012
	Shared Components 3.x

	U2 Basic Developer Toolkit
	U2 Basic Developer Toolkit 4.3.0
	U2 Basic Developer Toolkit 4.2.0
	U2 Basic Developer Toolkit 4.1.0
	U2 Basic Developer Toolkit 3.2.1
	U2 Basic Developer Toolkit 3.2.0
	U2 Basic Developer Toolkit 3.1.2
	U2 Basic Developer Toolkit 3.1.1
	U2 Basic Developer Toolkit 3.1.0
	U2 Basic Developer Toolkit 3.0.5
	U2 Basic Developer Toolkit 3.0.4
	U2 Basic Developer Toolkit 3.0.3
	U2 Basic Developer Toolkit 3.0.2
	U2 Basic Developer Toolkit 3.0.1
	Basic Developer Toolkit 3.0.0
	Basic Developer Toolkit 1.2.4
	Basic Developer Toolkit 1.2.1
	Basic Developer Toolkit 1.1.3

	U2 EDA Replication Configuration Tool
	U2 EDA Replication Configuration Tool 4.83.0
	U2 EDA Replication Configuration Tool 4.82.0
	U2 EDA Replication Configuration Tool 4.81.0
	U2 EDA Replication Configuration Tool 3.82.1
	U2 EDA Replication Configuration Tool 3.82.0
	U2 EDA Replication Configuration Tool 3.81.2
	U2 EDA Replication Configuration Tool 3.81.1
	U2 EDA Replication Configuration Tool 3.81.0
	U2 EDA Replication Configuration Tool 3.80.0

	U2 EDA Schema Manager
	U2 EDA Schema Manager 4.33.0
	U2 EDA Schema Manager 4.32.0
	U2 EDA Schema Manager 4.31.0
	U2 EDA Schema Manager 3.32.1
	U2 EDA Schema Manager 3.32.0
	U2 EDA Schema Manager 3.31.2
	U2 EDA Schema Manager 3.31.1
	U2 EDA Schema Manager 3.31.0
	U2 EDA Schema Manager 3.30.1
	EDA Schema Manager 3.30.0
	EDA Schema Manager 1.2.3

	U2 Metadata Manager
	U2 Metadata Manager 4.73.0
	U2 Metadata Manager 4.72.0
	U2 Metadata Manager 4.71.0
	U2 Metadata Manager 3.73.1
	U2 Metadata Manager 3.73.0
	U2 Metadata Manager 3.72.2
	U2 Metadata Manager 3.72.1
	U2 Metadata Manager 3.72.0
	U2 Metadata Manager 3.71.0
	U2 Metadata Manager 3.70.2
	U2 Metadata Manager 3.70.1
	U2 Metadata Manager 3.70.0

	U2 RESTful Web Services
	U2 RESTful Web Services 4.63.0
	U2 RESTful Web Services 4.62.0
	U2 RESTful Web Services 4.61.0
	U2 RESTful Web Services 3.62.1
	U2 RESTful Web Services 3.62.0
	U2 RESTful Web Services 3.61.2
	U2 RESTful Web Services 3.61.1
	U2 RESTful Web Services 3.61.0
	U2 RESTful Web Services 3.60.7
	U2 RESTful Web Services 3.60.5
	U2 RESTful Web Services 3.60.4
	U2 RESTful Web Services 3.60.3
	U2 RESTful Web Services 3.60.2
	U2 RESTful Web Services 3.60.1
	U2 RESTful Web Services 3.60.0

	U2 Web Services Developer
	U2 Web Services Developer 4.23.0
	U2 Web Services Developer 4.22.0
	U2 Web Services Developer 4.21.0
	U2 Web Services Developer 3.22.1
	U2 Web Services Developer 3.22.0
	U2 Web Services Developer 3.21.2
	U2 Web Services Developer 3.21.1
	U2 Web Services Developer 3.21.0
	U2 Web Services Developer 3.20.4
	U2 Web Services Developer 3.20.3
	U2 Web Services Developer 3.20.2
	U2 Web Services Developer 3.20.2
	U2 Web Services Developer 3.20.1
	Web Services Developer 3.20.0
	Web Services Developer 1.2.5
	Web Services Developer 1.2.4
	Web Services Developer 1.2.3
	Web Services Developer 1.2.2
	Web Services Developer 1.2.1
	Web Services Developer 1.1.2

	U2 Extensible Administration Tool
	U2 Extensible Administration Tool 4.13.0
	U2 Extensible Administration Tool 4.12.0
	U2 Extensible Administration Tool 4.11.0
	U2 Extensible Administration Tool 3.12.1
	U2 Extensible Administration Tool 3.12.0
	U2 Extensible Administration Tool 3.11.2
	U2 Extensible Administration Tool 3.11.1
	U2 Extensible Administration Tool 3.11.0
	U2 Extensible Administration Tool 3.10.9
	U2 Extensible Administration Tool 3.10.8
	U2 Extensible Administration Tool 3.10.6
	U2 Extensible Administration Tool 3.10.5
	U2 Extensible Administration Tool 3.10.4
	U2 Extensible Administration Tool 3.10.3
	U2 Extensible Administration Tool 3.10.2
	U2 Extensible Administration Tool 3.10.1
	Extensible Administration Tool 3.10.0
	Extensible Administration Tool 2.1.4
	Extensible Administration Tool 2.1.3

	U2 XML/DB Tool
	U2 XML/DB Tool 4.43.0
	U2 XML/DB Tool 4.42.0
	U2 XML/DB Tools 4.41.0
	U2 XML/DB Tool 3.42.1
	U2 XML/DB Tool 3.42.0
	U2 XML/DB Tool 3.41.2
	U2 XML/DB Tool 3.41.1
	U2 XML/DB Tool 3.41.0
	U2 XML/DB Tool 3.40.1
	XML/DB Tool 3.40.0
	XML/DB Tool 1.3.5
	XML/DB Tool 1.3.4
	XML/DB Tool 1.3.3
	XML/DB Tool 1.3.2
	XML/DB Tool 1.3.1

	XTOOLSUB
	XTOOLSUB 4.103.0
	XTOOLSUB 4.102.0
	XTOOLSUB 4.101.0
	XTOOLSUB 3.102.2
	XTOOLSUB 3.102.0
	XTOOLSUB 3.101.0
	XTOOLSUB 3.100.4
	XTOOLSUB 3.100.1
	XTOOLSUB 3.100.0


